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About This Guide
Before you start working in your rating system, browse through this
User’s Guide to see what functions the rating package can offer you.
We designed this guide to help you efficiently explore and use the
rating system regardless of your background with our software or
with computers in general.  Because it deals strictly with this rating
system, we have assumed you are already familiar with general
insurance terms and procedures for rating.

Organization of Guides
Your User’s Guide is divided into three sections. The first section,
Getting Started, includes chapters 1-5. It tells you how to install,
configure, and start your rating system. It also includes basic
information about workflow and moving around the system.

The second section, Quoting, includes chapters 6-14. It gives you the
information you need to put your client information into the computer
and calculate a quote.

Chapters 15-19 make up the third section, Advanced Functions. This
section contains information about more advanced features of the
system.

You may also have received a Training Guide, which is a step-by-step
introduction to your rating program.
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Visual Cues

Throughout the guide, various icons in the margin cue you to special
information:

The tack indicates a general note in the text.

The stop sign indicates a very important, “read-this-
before-you-go-any-further” message.

The ribbon indicates a feature new to the rating system--
helpful information if you are converting from an older
system.

The clock indicates a time-saving feature.

NEW!
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About This System
Your new rating system is a powerful, easy-to-use system that saves
you time and money by helping you process more applications in less
time. You enter your client information and then rate one or more
plans, with the rating system automatically computing rate classes,
sub-classes, discounts, surcharges, and factors.

If you care to play “what if” with the rates, you can easily change the
deductible, territory, or any other factor and re-rate. When you have a
satisfactory rate, you print an ACORD form facsimile ready for
submission.

You can even send a customized letter or proposal to your client,
automatically merging rate information into your letter.

If you have any problems using this rating system and you can’t find
the answers in this User’s Guide, call Technical Support.

Checking your Package

Your package should include the following items:

• Diskettes. Follow the instructions in your Installation Card
or User’s Guide to install your diskettes.

• Installation Card . This card has instructions for installing
your system the first time as well as for installing rate
updates.

• User’s Guide. If you have a question, check the User’s
Guide.

• Quick Reference Card. Located in the pocket of your
binder, the Quick Reference Card is a summary of shortcuts
and commands that you can keep near your keyboard.

• Hardware Information Card . Please fill this card out and
return it to us.
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You may also have received Update Bulletins, which explain changes
made to the rating program after the documentation was printed.

If your package is missing any of these items or if you need to order
additional copies, please call Technical Support.

Checking your Equipment

Your rating system requires the following minimum hardware:

• IBM XT/AT, System II, or IBM 100% compatible MS-DOS
386 Computer

• At least 512K free internal memory (from the DOS prompt)
per workstation

• Hard drive with at least 10 megabytes of available storage
for the first state and 3 meg for each additional state

• VGA color or monochrome monitor

• IBM or MS DOS version 5.0 or higher

• Any printer capable of compressing print to 16.67 cpi  while
in the DOS environment

For the ACORD forms, you must have an HP Laserjet Series
II compatible printer

You may also have received Update Bulletins, which explain changes
made to the rating program after the documentation was printed.

If your package is missing any of these items or if you need to order
additional copies, please call Technical Support.
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Registering Your Product

To register your product with AMS Rating and to help us better serve
you should you have any system problems, we need some information
about your hardware.

If you are new to AMS Rating, please complete the Hardware
Information Card located in your package and return it to us.

If you have other AMS Rating products, you should have already
returned a Hardware Information Card. However, please call us if
you make any changes to your hardware.
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CHAPTER 1

Installing and Configuring (no
Pathfinder 4.0 or above or Pioneer
Plus System)

The steps for installing your system vary depending on whether you
have the Pathfinder 4.0 or above or the Pioneer Plus management
system. Pathfinder and Pioneer Plus are agency management
programs for such items as accounts payable and receivable. If you
have one of these programs, go to chapter 2 for your installation
instructions. Otherwise, follow the steps below.

Installing and configuring your system consists of three steps, which
you must do in order:

1. Installing the AMS Rating Menu
2. Configuring the AMS Rating Menu
3. Installing the system itself

If you are running under Windows 95, exit
Windows completely before installing.

Installing the AMS Rating Menu
The AMS Rating Menu allows you to access programs and set up
common information, such as printers. You install this menu first.
You then use the Install AMS Products option on the Utilities Menu
of the AMS Rating Menu to install programs.

The AMS Rating Menu comes to you as a group of “copysets.” A
copyset is one or more diskettes of related programs. You install each
copyset separately. The diskettes are labeled and numbered: you must
install the diskettes in numbered order.

If you are
installing on an
Alloy system,
you must be in
single-user
mode.

You must install
the AMS Rating
Menu before
you can install
your  system.
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Follow the instructions below to install the AMS Rating Menu. To
install on an Alloy system, you must be in single-user mode.

1. Insert the first diskette of the AMS Rating Menu copyset into the
selected floppy drive.

In step 2 below, replace the question mark with the
drive letter of the selected floppy drive (usually A:).

2. Type ?:INSTALL
3. Press J. The Important Reminder Box is displayed.

4. Use the chart below to determine your next step:

If you want to… Then…

Continue the installation Press J. The AMS
Installation Box is displayed.
Continue to step 5.

Cancel the installation 1.Press F to select the
so you can back up Cancel pushbutton.
your files 2.Press J twice. After

you back up your system,
start the installation process
over again from step 1.
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you back up your system,
start the installation process
over again from step 1.
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5. Type the drive letter (and the directory name if necessary) where
you want to install the AMS Rating Menu.

If you are installing on a network, the path must
include a drive that all users can access. Use the
letter of a shared network drive.

6. Press J. The installation process begins.
7. Insert the remaining diskettes in the copyset in order as the

computer prompts you. When all the diskettes in the copyset have
been loaded, the Load AMS Software Dialog Box is displayed.

8. Press J. The AMS Rating Menu is now installed and you
return to the hard drive prompt.

9. Remove the diskette from the floppy drive. Store your AMS
Rating Menu diskettes in a safe place and continue to the next
section to configure your AMS Rating Menu.

5. Type the drive letter (and the directory name if necessary) where
you want to install the AMS Rating Menu.

If you are installing on a network, the path must
include a drive that all users can access. Use the
letter of a shared network drive.

6. Press J. The installation process begins.
7. Insert the remaining diskettes in the copyset in order as the

computer prompts you. When all the diskettes in the copyset have
been loaded, the Load AMS Software Dialog Box is displayed.

8. Press J. The AMS Rating Menu is now installed and you
return to the hard drive prompt.

9. Remove the diskette from the floppy drive. Store your AMS
Rating Menu diskettes in a safe place and continue to the next
section to configure your AMS Rating Menu.
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Configuring the AMS Rating Menu

The first time you enter the AMS Rating Menu, you have to set up
stations and select printers. You also have to indicate whether it is to
be a single-user or multi-user system and enter user information.

The steps for configuring the system vary depending on whether you
want to set the system up as single-user or multi-user. To configure
your system as multi-user, skip to page 12.

Single-User Systems

To configure the AMS Rating Menu as a single-user system,

1. At the hard drive prompt where the AMS Rating Menu is stored,
type AMSRATE

2. Press J.  The System Information Dialog Box is displayed.

3. If you want the user to enter a password when accessing the
AMS Rating Menu, press F until the Force Passwords option
is highlighted. Otherwise, skip to step 5.

4. Press s to mark the Force Passwords field.

Configuring the AMS Rating Menu

The first time you enter the AMS Rating Menu, you have to set up
stations and select printers. You also have to indicate whether it is to
be a single-user or multi-user system and enter user information.

The steps for configuring the system vary depending on whether you
want to set the system up as single-user or multi-user. To configure
your system as multi-user, skip to page 12.

Single-User Systems

To configure the AMS Rating Menu as a single-user system,

1. At the hard drive prompt where the AMS Rating Menu is stored,
type AMSRATE

2. Press J.  The System Information Dialog Box is displayed.

3. If you want the user to enter a password when accessing the
AMS Rating Menu, press F until the Force Passwords option
is highlighted. Otherwise, skip to step 5.

4. Press s to mark the Force Passwords field.
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5. Press J. The Printer Information Box is displayed.

6. Highlight the printer you want to select.

The alphabetical list of printers is first-letter sensitive.
Therefore (unless your printer starts with an A), the
fastest way to highlight the printer is to type its first
letter. The highlight moves to the first printer starting
with that letter. If that isn’t the printer you want, use the
up and down arrow keys to move to the right printer.

7. Press F to move to the Ports list box.
8. Use the up and down arrow keys to highlight the port. If you

select COM1 or COM2, you need to initialize the printer with the
DOS “MODE” command.

During
configuration,
you select one
printer. You can
add other
printers later by
selecting
Printer from the
Setup Menu.

If you select
COM1 or
COM2 as the
port, you need
to initialize the
printer with the
DOS “MODE”
command.

5. Press J. The Printer Information Box is displayed.

6. Highlight the printer you want to select.

The alphabetical list of printers is first-letter sensitive.
Therefore (unless your printer starts with an A), the
fastest way to highlight the printer is to type its first
letter. The highlight moves to the first printer starting
with that letter. If that isn’t the printer you want, use the
up and down arrow keys to move to the right printer.

19. Press F to move to the Ports list box.
20. Use the up and down arrow keys to highlight the port. If you

select COM1 or COM2, you need to initialize the printer with the
DOS “MODE” command.

During
configuration,
you select one
printer. You can
add other
printers later by
selecting
Printer from the
Setup Menu.

If you select
COM1 or
COM2 as the
port, you need
to initialize the
printer with the
DOS “MODE”
command.
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9. Press J. The Agency Information Dialog Box is displayed.

10. Type your agency’s name, address, phone number, and fax
number, pressing J or F to move from field to field.

11. When the box is filled out, type A + O at the same time to
select the OK pushbutton. The AMS Rating Menu is displayed.

Now that you have configured your AMS Rating Menu, continue to
Installing your System, beginning on page 16.

Multi-User Systems

You must configure your AMS Rating Menu as multi-user if it is
being used on multiple stations. You must configure each station
individually.

You can also configure a stand-alone computer as multi-user: you
may want to do this if more than one person will be using the system.

To configure the AMS Rating Menu for a multi-user system,

1. At the hard drive prompt where the AMS Rating Menu is stored,
type AMSRATE

If you are starting from an Alloy host, type AMSRATE HOST

During
configuration,
you enter one
agency. You
can add other
agencies later
by selecting the
Agency option
from the Setup
Menu.

21. Press J. The Agency Information Dialog Box is displayed.

22. Type your agency’s name, address, phone number, and fax
number, pressing J or F to move from field to field.

23. When the box is filled out, type A + O at the same time to
select the OK pushbutton. The AMS Rating Menu is displayed.

Now that you have configured your AMS Rating Menu, continue to
Installing your System, beginning on page 16.

Multi-User Systems

You must configure your AMS Rating Menu as multi-user if it is
being used on multiple stations. You must configure each station
individually.

You can also configure a stand-alone computer as multi-user: you
may want to do this if more than one person will be using the system.

To configure the AMS Rating Menu for a multi-user system,

1. At the hard drive prompt where the AMS Rating Menu is stored,
type AMSRATE

If you are starting from an Alloy host, type AMSRATE HOST

During
configuration,
you enter one
agency. You
can add other
agencies later
by selecting the
Agency option
from the Setup
Menu.
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2. Press J.  If you are at an Alloy host, skip to step 27.
Otherwise, the System Information Dialog Box is displayed.

3. Press F to move to the System Usage section.
4. Press b to mark the Multi User option.
5. If you want the user to enter a password when accessing the

AMS Rating Menu, press F until the Force Passwords option
is highlighted. Otherwise, skip to step 7.

6. Press s to mark the Force Passwords field.
7. Press J. The Station Information Dialog Box is displayed.

8. In the Identifier field, type a name for the station (such as the
location or primary user’s name).

If you have an
Alloy system,
the config-
uration is done
automatically.
You will need to
select a printer
later from the
Setup Menu.

See the
Advanced
Functions
section for
instructions on
mapping
alternate
workstation
drives.
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9. Press F to go to the Monitor Type field.
10. Press b to select the appropriate monitor.
11. Press F to go to the Palette Settings field.
12. Press b to select the type of palette.

Unless you definitely know you need to change the
rest of the fields on this screen, it is best to accept
the defaults. Skip to step 19.

If you do need to change a selection, continue with
step 13 below. You can also press AAAAA + the hot
key (letter that is a different color) to move directly
to a field you want to change.

13. Press F to go to the Use BIOS field.
14. If direct screen writes should not be allowed, press s to

check this field (screen display will slow slightly).
15. Press F to go to the Snow Check field.
16. If your monitor flickers or has snow during the display, press

s to check this option and reduce the problem (screen
display will slow slightly).

17. Press F to go to the 24 Line Display field.
18. To view the screens on a 24-line display, press s to check

this option.
19. Press J. The Printer Information Dialog Box is displayed.During

configuration,
you select one
printer. You can
add other
printers later by
selecting
Printer from the
Setup Menu.

9. Press F to go to the Monitor Type field.
10. Press b to select the appropriate monitor.
11. Press F to go to the Palette Settings field.
12. Press b to select the type of palette.
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display will slow slightly).

17. Press F to go to the 24 Line Display field.
18. To view the screens on a 24-line display, press s to check

this option.
19. Press J. The Printer Information Dialog Box is displayed.During

configuration,
you select one
printer. You can
add other
printers later by
selecting
Printer from the
Setup Menu.
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20. Highlight the printer you want to select.

The alphabetical list of printers is first-letter
sensitive. The fastest way to highlight the printer is
to type its first letter. The highlight moves to the
first printer starting with that letter. If that isn’t the
printer you want, use the up and down arrow keys
to move to the right printer.

21. Press F to move to the Ports list box.
22. Press b to select the port. If you select COM1 or COM2 as the

port, you need to initialize the printer with the DOS “MODE”
command.

23. Press J. The User Information Dialog Box is displayed.

During configuration, the Agency field is read-only:
your cursor skips this field. The first agency you
enter on Agency Information will be the default
selection in this field. Once the AMS Rating Menu
is configured, you can use the Setup option to
enter more agencies and to change the agency
selected in this field.

24. In the name field, type the user name.
25. If you want the user to enter a password, press F to move to

the Password field. Otherwise, skip to step 29.
26. Type the password.
27. Press J. A confirmation box is displayed.
28. Type the password again.

If you select
COM1 or
COM2 as the
port, you need
to initialize the
printer with the
DOS “MODE”
command.

During
configuration,
you enter one
user. You can
add other users
later by
selecting User
from the Setup
Menu.
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During configuration, the Agency field is read-only:
your cursor skips this field. The first agency you
enter on Agency Information will be the default
selection in this field. Once the AMS Rating Menu
is configured, you can use the Setup option to
enter more agencies and to change the agency
selected in this field.

22. In the name field, type the user name.
23. If you want the user to enter a password, press F to move to

the Password field. Otherwise, skip to step 29.
24. Type the password.
25. Press J. A confirmation box is displayed.
26. Type the password again.

If you select
COM1 or
COM2 as the
port, you need
to initialize the
printer with the
DOS “MODE”
command.

During
configuration,
you enter one
user. You can
add other users
later by
selecting User
from the Setup
Menu.
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29. Press J. The Agency Information Dialog Box is displayed.

30. Type your agency’s name, address, phone number, and fax
number, pressing J or F to move from field to field.

31. When the box is filled out, press A + O at the same time to
select the OK pushbutton. The AMS Rating Menu is displayed.

Now that you have configured your AMS Rating Menu, continue to
the “Installing your System” section starting below to install your
new system.

Installing your System

Once you have installed and configured the AMS Rating Menu, you
install the rest of your diskettes using the Install AMS Products
option on the Utilities Menu. To do so,

1. At the AMS Rating Menu, type U to select and open the Utilities
Menu.

27. Press J. The Agency Information Dialog Box is displayed.

28. Type your agency’s name, address, phone number, and fax
number, pressing J or F to move from field to field.

29. When the box is filled out, press A + O at the same time to
select the OK pushbutton. The AMS Rating Menu is displayed.

Now that you have configured your AMS Rating Menu, continue to
the “Installing your System” section starting below to install your
new system.

Installing your System

Once you have installed and configured the AMS Rating Menu, you
install the rest of your diskettes using the Install AMS Products
option on the Utilities Menu. To do so,

1. At the AMS Rating Menu, type U to select and open the Utilities
Menu.
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2. Type I  to select the Install AMS Products option from the
Utilities Menu. The Important Reminder Dialog Box is
displayed.

3. Use the chart below to determine your next step:

If you want to… Then…

Continue the installation Press J. The Select
Drive Dialog Box is displayed.
Continue to step 4.

Cancel the installation 1.Press F to select the
so you can back up Cancel pushbutton.
your files 2.Press J twice. After

you back up your system,
start the installation process
over from step 1.

2. Type I  to select the Install AMS Products option from the
Utilities Menu. The Important Reminder Dialog Box is
displayed.

3. Use the chart below to determine your next step:

If you want to… Then…

Continue the installation Press J. The Select
Drive Dialog Box is displayed.
Continue to step 4.

Cancel the installation 1.Press F to select the
so you can back up Cancel pushbutton.
your files 2.Press J twice. After

you back up your system,
start the installation process
over from step 1.
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4. If you are installing from Drive A, continue to step 5 now.

If you are installing from another drive, type the drive letter.

5. Insert the first disk of the copyset into the selected floppy drive
and press J. The AMS Installation Dialog Box may be
displayed, depending on what you are installing.

If this box is displayed, continue to step 6. Otherwise, skip to
step 8.

6. Type the drive letter (and the directory name if necessary) where
you want to install the program/update.

If you are installing on a network, the path must
include a drive that all users can access. Use the
letter of a shared network drive.

7. Press J. The installation process begins.
8. Insert the remaining diskettes in the copyset in order as the

computer prompts you to.

4. If you are installing from Drive A, continue to step 5 now.

If you are installing from another drive, type the drive letter.

5. Insert the first disk of the copyset into the selected floppy drive
and press J. The AMS Installation Dialog Box may be
displayed, depending on what you are installing.

If this box is displayed, continue to step 6. Otherwise, skip to
step 8.

6. Type the drive letter (and the directory name if necessary) where
you want to install the program/update.

If you are installing on a network, the path must
include a drive that all users can access. Use the
letter of a shared network drive.

7. Press J. The installation process begins.
8. Insert the remaining diskettes in the copyset in order as the

computer prompts you to.
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When you have loaded all the diskettes in the copyset, the Load
AMS Software Dialog Box is displayed.

9. If you have another copyset to install,

9-1.Press J.
9-2.Insert the first diskette of the new copyset into the same

floppy drive.
9-3.Press J.
9-4.Repeat steps 6-9 for each remaining copyset.

10. Once you have loaded all the copysets,

10-1. Press F to select the Done pushbutton.
10-2. Press J. Another Installation Successful message

is displayed.
10-3. Press J. The copyset is now installed and you

return to the AMS Rating Menu.

Congratulations! Your system is now installed!

When you have loaded all the diskettes in the copyset, the Load
AMS Software Dialog Box is displayed.

9. If you have another copyset to install,

9-1.Press J.
9-2.Insert the first diskette of the new copyset into the same

floppy drive.
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10. Once you have loaded all the copysets,

10-1. Press F to select the Done pushbutton.
10-2. Press J. Another Installation Successful message

is displayed.
10-3. Press J. The copyset is now installed and you

return to the AMS Rating Menu.

Congratulations! Your system is now installed!
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CHAPTER 2

Installing and Configuring with
Pathfinder 4.0 and Above or
Pioneer Plus

If you have Pathfinder 4.0 and above or Pioneer Plus, you must
install ALL your diskettes from the Load AMS Software option on
the Frontier Menu.

Your AMS programs, including the AMS Rating Menu, Personal and
Commercial Lines Rating, and File Miner, come to you as a group of
“copysets.” A copyset is one or more diskettes that make up a
program. For example, the AMS Rating Menu is one copyset made
up of multiple diskettes.

Each copyset is clearly labeled and numbered. When you install a
new copyset, always install them in numbered order. Also note that
you must install each copyset separately, and you must install the
AMS Rating Menu diskettes first.

Follow the instructions below to install your software:

Please note the order in which you install
diskettes. You must install the AMS Rating Menu
diskettes first.

1. Make sure all users have logged off their systems.
2. Insert the first diskette of the copyset into the selected floppy

drive.
3. Select Setup from the Frontier Menu.
4. Select Load AMS Software from the Setup Menu.

CHAPTER 2
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Pioneer Plus
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2. Insert the first diskette of the copyset into the selected floppy

drive.
3. Select Setup from the Frontier Menu.
4. Select Load AMS Software from the Setup Menu.



Getting Started

12/9/97 22

Getting Started

12/9/97 22

5. Follow the instructions on the screen to complete the installation.
You must install every diskette in your package in order for
integration to work.

6. After you have loaded all the diskettes, reboot your Frontier
System to update the menu and security files.

5. Follow the instructions on the screen to complete the installation.
You must install every diskette in your package in order for
integration to work.

6. After you have loaded all the diskettes, reboot your Frontier
System to update the menu and security files.
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CHAPTER 3

Starting and Exiting your System
The instructions for starting your system are different for single-user
and multi-user systems.

If you use any AMS Management System (Pathfinder 3.5 or above or
Pioneer), skip this section. Just start your system as you normally do.

Starting a Single-User System

To start your system,

1. At the hard drive prompt where the AMS Rating Menu is stored,
type AMSRATE

2. Press J. If no password is required, the AMS Rating Menu is
displayed; skip to step 5. If a password is required, continue to
step 3.

3. Type your password.
4. Press J. The AMS Rating Menu is displayed.
5. Press J to open the highlighted AMS option. The AMS Menu

is displayed.
6. Type P to choose Personal Lines. The Workflow Dialog Box is

displayed.

When you are ready to begin rating, go to Chapter 6 for instructions.

If you use an
AMS Manage-
ment System,
skip this section
and start up as
you normally
do.
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Starting a Multi-User System
To start your program on a multi-user system,

1. At the hard drive prompt where the AMS Rating Menu is stored,
type AMSRATE

From an Alloy host, type AMSRATE HOST

If you have set up a customized file name, type AMSRATE plus
your file name.

2. Press J.

If you are starting from an Alloy host or if you used a customized
file name, the AMS Rating Menu is displayed. Skip to step 5.

 Otherwise, the list of users is displayed: continue to step 3.

3. Press b to highlight the user you want to select.
4. Press J. The AMS Rating Menu is displayed.
5. Press J to open the highlighted AMS option. The AMS Menu

is displayed.
6. Type P to choose Personal Lines. The Workflow Dialog Box is

displayed.

When you are ready to begin rating, go to Chapter 6 for instructions.

Exiting the System

When you are ready to exit your program, you can press 3 or
select the Exit option from the File Menu.

When you are ready to exit the AMS Rating Menu, press 3 again
or select Exit from the AMS Menu.

Use Customize
Sign-on from
the Utilities
Menu to set up
a customized
file name,
making it faster
and easier to
start up a multi-
user system.
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CHAPTER 4

Moving Around in Your System
This chapter helps you more easily move around in your program. It
covers the following items:

• Definitions
• General workflow
• Moving around on the input screens
• Selecting options on the action bar and pulldown menus
• Filling out dialog boxes
• Keyboard shortcuts

Please note that the screens in this section are samples only, and may
not be the same screens you see in your system. Also note that this
section covers keyboard movements; you can also use your mouse.

Definitions

This section defines common terms used in your rating system.

Action Bar

The action bar is the list of choices at the top of your screen. The
figure below is an example of an Action Bar. A similar Action Bar
appears across the top of each screen.

,

Each item on the action bar has a pulldown menu listing actions the
system can do: for example, saving a quote or pulling up messages.

You can use
your mouse in
this rating
system.
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Detail Quote

Detail quote is a rating process in which you complete all fields on
the input screens before calculating a quote. Also see Quick Quote.

Hot Key

The hot key is the highlighted letter of a menu option or pushbutton.
It is usually the first letter of the word. You can quickly select an
option or pushbutton by pressing A + the hot key.

Pulldown Menu

The pulldown menu is the list of choices under each menu of the
action bar. It “pulls down” under the menu.

Pushbutton

Pushbuttons are the options in brackets < > on the bottom of a
screen or pop-up box that you select to perform an action. The
brackets around the default pushbutton are highlighted.

Quick Quote

Quick quote is a rating process in which you answer only specified,
necessary questions on a series of  pop-up boxes before calculating a
quote. You specify through defaults what questions should be
included in the Quick Quote. Also see Detail Quote.
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General Workflow

The basic workflow you follow when using the system is outlined
below:

1. Type in your client information, including limits and deductibles.
You may choose to do a “quick” quote or a “full” quote.

2. Calculate the premium for one or more companies.
3. If necessary, make any changes needed to the client information.
4. Select a company and print quotes and ACORD forms.

Of course, many other options are available in these four basic steps,
such as setting defaults and printing letters.

Tasks you can perform are listed on the Workflow Dialog Box. An
abbreviated version of this box is displayed when you start your
system, or you can bring up the full list any time by pressing 2. In
addition, most tasks are also listed on one of the Action Bar menus at
the top of the screen.

Whenever you
don’t know how
to do
something,
press 2 to
bring up the
Workflow
Dialog Box.
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Moving Around on the Input Screens
If you are completing or editing a full quote, then you are working on
a screen similar to the one below:

Each field on an input screen is either an entry field, an 4=Detail
field, or an 4 edit field:

• In an entry field, you type the requested information.
• In an 4=Detail field, you press 4 or click on the field

with your mouse to bring up another dialog box in which you
enter detailed information

• In an 4 edit field, you have multiple ways to select an
option. You can either

• Press J to accept the displayed default
• Press s to roll through all the options one after the

other, pressing J when the option you want to select is
displayed

• Type the first letter of the option you want to select
• Press 4 to bring up a list of the available options, from

which you can select
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The table below lists some other keys for moving around on the input
screens:

To... Press...

Move from one field to the next J or F
Move back to a previous field V + F
Clear a field C + Y
Move from column to column r or l

If you have the “r to add item” field marked on the Preferences
Dialog Box, you can also add an item by pressing r in the last
completed column.

You can leave a screen as soon as you have filled in all the needed
information on that screen. You do not have to press J  through
every field. (If you do press J through every field, when you get to
the last field, the system will ask if you want to add another item or
go the next screen.) When you are done with a screen, you can go to
another input screen, or you can use the Workflow Dialog Box,  the
Action Bar, or a function key to move to another part of the system.

To move to another screen, either

• Press the u or  d key
• Click on the pushbutton (listed at the bottom of each screen)

for the option you want
• Press A + the pushbutton hot key: to go to the Vehicle

Screen, for example, you would press A + V
• Press F until the pushbutton for the screen you want is

highlighted, and then press J
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Selecting Options on the Action Bar and
Pulldown Menus

The action bar is the list of choices at the top of your screen. The
figure below is an example of an Action Bar. A similar Action Bar
appears across the top of each screen.

,

You select an option from the Action Bar to move from one section of
a program to another and to tell the program what you want to do.

You can access the action bar by

• Clicking on an item with your mouse
• Pressing  A + the hot key
• Pressing  0 to move to the action bar and then typing the

hot key

Either way, a menu pulls down beneath the option you select, as
shown below. This Pulldown Menu lists the individual commands
available within that section of the program.

The hot key is
usually the first
letter of the
option. It is also
a different color
than the rest of
the word.
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You can select an item from a pulldown menu by either

• Clicking on an item with your mouse
• Pressing  the hot key

Many items on the pulldown menu also have quick keys listed next to
the item. You can press the quick keys to access the item anytime.
For example, you can press C + S to save a quote instead of going
to the File Menu and selecting the Save option.

Filling Out Dialog Boxes

When the rating system needs you to enter additional information, a
dialog box may be displayed so you can communicate with the
system. When you have “answered” the dialog box, it disappears
from the screen.

Below is an example of a dialog box:

List List

Pushbuttons s fields

Entry Field

You can select an item from a pulldown menu by either

• Clicking on an item with your mouse
• Pressing  the hot key

Many items on the pulldown menu also have quick keys listed next
to the item. You can press the quick keys to access the item
anytime. For example, you can press C + S to save a quote
instead of going to the File Menu and selecting the Save option.

Filling Out Dialog Boxes

When the rating system needs you to enter additional information, a
dialog box may be displayed so you can communicate with the
system. When you have “answered” the dialog box, it disappears
from the screen.

Below is an example of a dialog box:

List List

Pushbuttons s fields

Entry Field
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Dialog boxes have one or more sections. Our sample dialog box has
six sections: an edit field, two lists, two s fields, and
pushbuttons The cursor or highlight shows you which section you are
in. The following pages tell you how to make selections within a
section, move from section to section, and close a dialog box.

Making a Selection

You make selections in dialog boxes through

• Lists
• Entry fields
• s fields

Lists

The figure below shows an example of a list.

To select an option in a list, press b and t to move through the
choices.

You may also see lists where you can select more than one item. To
select items in such a list,

1. Press b and t to move the highlight to the item you want to
select.

2. Press s to mark the item.
3. Repeat steps one and two for all other items in the list you want

to select.
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Entry Fields

In some fields, you type or edit information. These fields are either
blank or have text you can edit, as shown in the figure below.

sssss Fields

Some fields in dialog boxes are s entries. To make a selection
in a s field, press s to mark the option. The figure
below shows an example of s fields.

Entry Fields

In some fields, you type or edit information. These fields are either
blank or have text you can edit, as shown in the figure below.

sssss Fields

Some fields in dialog boxes are s entries. To make a selection
in a s field, press s to mark the option. The figure
below shows an example of s fields.
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Moving from Section to Section

How you move from section to section depends on whether you have
marked the RETURN act as TAB field in the Preferences Dialog Box.
When you get your system, this field is unmarked and you must press
F to move from section to section in a dialog box. If you mark the
field, then you can press F or J  to move from section to section.

You can also press A + the hot key to go directly to a field, or use
your mouse to click in a field.

Closing a Dialog Box

Dialog boxes have one or more pushbuttons that you use when you
have completed each section of the box, to tell the computer you are
done and ready to continue. The figure below shows an example of a
set of pushbuttons:

To exit the dialog box, you select the appropriate pushbutton. How
you select a pushbutton depends on whether you have marked the
RETURN act as TAB field in the Preferences Dialog Box. When you
get your system, this field is unmarked and you can press J
anytime to accept the default pushbutton and close the dialog box.
However, if you have marked this field or you want to select a
different pushbutton, you can do so by either

• Clicking on it with your mouse
• Pressing A + the hot key
• Pressing F until the pushbutton is highlighted and then

pressing J
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Keyboard Shortcuts

The table below lists keys for moving around on input screens:

Key… Function…

J Move from field to field

V + F Move backward from field to field

t  and b Move through items in a list

A + hot key Select a pushbutton

s Move through the options in an 4 edit
field

4 See a list of options in an 4 edit field

The table below lists Action Bar keys:

Key… Function…

0 Moves from the screen to the Action Bar

J If the pulldown menu is not open, opens it. If
the pulldown menu is open, selects the
highlighted item.

E If the pulldown menu is not open, returns the
cursor to the screen. If the pulldown menu is
open, closes the menu.

l and r Moves the highlight from menu to menu

t  and b Moves the highlight through items in a menu

A + hot key Moves from the screen to a specific option,
automatically opening the pulldown menu

hot key Selects the option on a pulldown menu

See the Quick Reference Card for other function keys.

The hot key is
usually the first
letter of the
command. It is
also a different
color than the
rest of the
word.
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CHAPTER 5

Getting Help
The AMS Rating Menu and your rating system have an expansive help
system containing information about each menu item and field on the
system. In addition, you can add your own comments to help screens.

To access the help system, press 1. The help screen for the
highlighted item appears. See the example help screen below:

Once you are at the Help Screen, you can

• Add or review User notes
• Go to the index of help topics
• Search for another help topic
• Get help for navigating around the system
• Go back to a previous help screen
• Exit the Help Screen
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Adding or Reviewing User Notes

To add or review your own notes about the system,

1. Type A + G to select the AGENCY option.
2. Press t to move to the top of the Comments Screen.
3. Type your comments.

Going to the Index

Each screen in the Help System is listed in the Index of topics. You
can move from topic to topic by going to the index.

To go to the index, press either V  + 1 OR A + I . The Topic
Index is displayed.

To select a topic from the index,

1. Highlight the topic you want to view.
2. Press J.
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Searching for a Topic

To search for a specific topic,

1. Type A + S to select the SEARCH pushbutton and display the
Search Dialog Box.

2. Type the word or phrase for which you are searching.
3. Type A + S to select the SHOW TOPICS pushbutton. A list of

topics matching your description is displayed.
4. Highlight the topic you want to select.
5. Type A + G to select the GO TO pushbutton. The help screen

for the selected topic is displayed.

Getting Navigation Help

To get help for moving around your system, press  A + N to select
the Navigation pushbutton.

Going Back to a Previous Help Screen

As you move from topic to topic, you “layer” Help Screens on top of
each other. To move backwards through the layers, press either  A
+ B OR A + 1.

Exiting the Help System

When you are ready to exit the Help System, type A + O to select
the OK pushbutton, or press E.
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Chapter 6

Entering Client Information
In your comparative rating program, you can do a “quick quote,” in
which only pre-determined questions are asked, or a detail quote, in
which you answer all questions. This chapter covers

• Using the Workflow Dialog Box
• Completing a Quick Quote
• Completing a Detail Quote

Using the Workflow Dialog Box

The Workflow Dialog Box lists tasks you can perform in your
rating program. The options on the Workflow Dialog Box vary
depending on where you are in the program.

In a quick quote,
you only answer
questions that
you have set up
as being vital to
a quote.

Whenever you
don’t know how
to do
something,
press 2 to
bring up the
Workflow
Dialog Box.
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The Workflow Dialog Box is displayed automatically when you
start your program. However, you can also bring up the Workflow
Dialog Box any time from any screen by either

• pressing 2
OR

• selecting the Workflow  option from the Options Menu

Once you see the Workflow Dialog Box, you

1. Press b and t to highlight the option you want to select.
2. Press J.

You can use the Workflow Dialog Box to start a new quote:

Select… To…

QUICK-QUOTE a new Start a quick quote for a
client/policy new (not previously saved) client and

policy

ADD a new client/quote Start a new detail quote for a new
client

Completing a Quick Quote
When you complete a quick quote, you only answer questions that
you have set up as being vital to a quote. The Advanced Functions
section tells you how to set up what questions you want to answer
during a quick quote.

You can do a quick-quote for a new client or for a loaded client
(for example, if you have rated auto for a client and now want to
rate home).

Also C  + Q

Also C  + N
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To complete a quick quote,

1. To start the quick quote, either

• Select QUICK-QUOTE a new client/policy from the 
Workflow Dialog Box

• Select Quick Quote from the File Menu
OR

• Press C + Q to quick-quote a new client/policy

The Policy Definition Dialog Box is displayed.

2. Press b and t to select the line of business you want.
3. Press A + O to select the OK button, or click on the OK

button with your mouse.
4. If you have more than one state of rating, the State

Determination Dialog Box is displayed.

4-1.Press b and t to highlight the state you want to rate.
4-2.Press A + O to select the OK button, or click on the OK

button with your mouse.

5. If you marked Pre-Select Defaults on the Preferences Dialog
Box, the Select Default Set Dialog Box is displayed. On this
dialog box, you choose a default set to be pre-loaded.

The choices on
your Policy
Definition
Dialog Box
vary according
to what rating
systems you
have loaded.

For more infor-
mation about the
Preferences
Dialog Box, see
the Advanced
Functions
section.

If you begin a
new quote
without saving
one you were
already working
on, the rating
system asks if
you want to
save before
continuing.

To complete a quick quote,

1. To start the quick quote, either

• Select QUICK-QUOTE a new client/policy from the 
Workflow Dialog Box

• Select Quick Quote from the File Menu
OR

• Press C + Q to quick-quote a new client/policy

The Policy Definition Dialog Box is displayed.

2. Press b and t to select the line of business you want.
3. Press A + O to select the OK button, or click on the OK

button with your mouse.
4. If you have more than one state of rating, the State

Determination Dialog Box is displayed.

4-1.Press b and t to highlight the state you want to rate.
4-2.Press A + O to select the OK button, or click on the OK

button with your mouse.

5. If you marked Pre-Select Defaults on the Preferences Dialog
Box, the Select Default Set Dialog Box is displayed. On this
dialog box, you choose a default set to be pre-loaded.
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To choose a default set,

5-1.Press b or t to highlight the default set you want to
load.

5-2.Press A + O to select the OK button, or click on the OK
button with your mouse.

6. If you marked Pre-Select Plans on the Preferences Dialog Box,
the Plan Selection Dialog Box is displayed.

To choose a default set,

5-1.Press b or t to highlight the default set you want to
load.

5-2.Press A + O to select the OK button, or click on the OK
button with your mouse.

6. If you marked Pre-Select Plans on the Preferences Dialog Box,
the Plan Selection Dialog Box is displayed.
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On this dialog box, you mark in advance the plans you want to
quote:

• To mark all plans, press 6
• To mark individual plans, highlight each plan you want to

mark, and press s to mark it

When all the plans you want to quote are marked, press A + S
to choose SELECT.

The first Quick-Quote box is displayed.

Remember that the fields displayed on the quick quote boxes vary
depending on what you have selected in the default sets. Below is a
sample quick quote box:

See the
Advanced
Functions
section for
instructions on
adding fields to
and deleting
fields from the
quick-quote.
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When all the plans you want to quote are marked, press A + S
to choose SELECT.

The first Quick-Quote box is displayed.

Remember that the fields displayed on the quick quote boxes vary
depending on what you have selected in the default sets. Below is a
sample quick quote box:

See the
Advanced
Functions
section for
instructions on
adding fields to
and deleting
fields from the
quick-quote.
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To complete quick-quote boxes,

1. Complete the field the cursor is in.

Each field is either an edit field or an options field. In an edit
field, you type the requested information. In an options field,
you can either:

• Press J to accept the displayed default
• Press s to roll through all the options one after

the other, pressing J when the option you want to
select is displayed

• Type the first letter of the option you want to select
• Press 4 to bring up a list of the available options,

from which you can select

If you aren’t sure what to enter in a specific field, press 1 to
see the on-line field help.

Some fields are marked with a colored (usually yellow)
question mark. These indicate company-specific questions. You
can press 1 to see what company the question is for and to
get more information about how to answer the question.

2. Press F to go to the next field.
3. When the box is complete, press A + N to select the NEXT

pushbutton and continue to the next dialog box.

Once you complete the last dialog box in the Quick Quote, the
Company Select Dialog Box is displayed. You can now begin rating,
or you can go to the input screens to add information that was not
asked on the quick quote screens. To add information,

1. Press E to exit the Company Select Screen.
2. Change or add whatever information you need to on the input

screens.
3. Press 8 to return to the Company Select Screen for rating.

Go to the “Rating” chapter for further instructions.

Company
questions are
marked with a
question mark.

Company
questions are
marked with a
question mark.

To complete quick-quote boxes,

1. Complete the field the cursor is in.
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you can either:

• Press J to accept the displayed default
• Press s to roll through all the options one after

the other, pressing J when the option you want to
select is displayed

• Type the first letter of the option you want to select
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see the on-line field help.
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get more information about how to answer the question.

2. Press F to go to the next field.
3. When the box is complete, press A + N to select the NEXT

pushbutton and continue to the next dialog box.

Once you complete the last dialog box in the Quick Quote, the
Company Select Dialog Box is displayed. You can now begin rating,
or you can go to the input screens to add information that was not
asked on the quick quote screens. To add information,

1. Press E to exit the Company Select Screen.
2. Change or add whatever information you need to on the input

screens.
3. Press 8 to return to the Company Select Screen for rating.

Go to the “Rating” chapter for further instructions.
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Completing a Detail Quote

The steps for starting a detail quote vary depending on how you
start and whether the client is new or has been saved. This section
covers

• Starting from the Action Bar
• Starting from the Workflow Dialog Box
• Starting from the Client List Dialog Box
• Filling Out the Auto and Home Screens

Starting from the Action Bar

To start a new quote from the action bar, select the New option
from the File Menu:

1. Type A + F to open the File Menu.
2. Type N to select the New option.

The Policy Definition Dialog Box is displayed. Go to the Filling out
the Auto and Home Screens section on page 50 to continue.

Starting from the Workflow Dialog Box

To use the Workflow Dialog Box to start a new quote,

1. Press 2 to bring up the Workflow Dialog Box.
2. Highlight ADD a new client/quote.
3. Press A + O to select the OK button, or click on the OK

button with your mouse.

The Policy Definition Dialog Box is displayed. Go to the Filling out
the Auto and Home Screens section on page 50 to continue.

Also C + N.

If you begin a
new quote
without saving
one you were
already working
on, the rating
system asks if
you want to
save before
continuing.

If you haven’t
saved an
earlier quote,
the rating
system asks if
you want to
save first.

If you haven’t
saved an
earlier quote,
the rating
system asks if
you want to
save first.
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Starting from the Client List Dialog Box

The Client List Dialog Box lists all the clients you have saved. You
can use this box to start a new quote for a new or an existing client.
You can only start detail quotes using the Client List Dialog Box.

You access the Client List Dialog Box by selecting either

• Load an Existing Client from the Workflow Dialog Box
OR

• Open from the File Menu.

To start a new quote for a new client,

1. At the Client List Dialog Box , type A + N at the same time to
select the New pushbutton.

The Policy Definition Dialog Box is displayed. Go to the Filling out
the Auto and Home Screens section on page 50 to continue.

Starting from the Client List Dialog Box

The Client List Dialog Box lists all the clients you have saved. You
can use this box to start a new quote for a new or an existing client.
You can only start detail quotes using the Client List Dialog Box.

You access the Client List Dialog Box by selecting either

• Load an Existing Client from the Workflow Dialog Box
OR

• Open from the File Menu.

To start a new quote for a new client,

1. At the Client List Dialog Box , type A + N at the same time to
select the New pushbutton.

The Policy Definition Dialog Box is displayed. Go to the Filling out
the Auto and Home Screens section on page 50 to continue.
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To start a new quote for an existing client,

If you already have a client on your system and want to do another
quote for that client (for example, you have rated their auto and
now want to rate their home), follow the instructions below:

1. At the Client List Dialog Box, either type the name of the client
you want to load (skip to step 3), type part of the name, or
press F to move to the list of clients.

2. Press b and t to highlight the client for whom you want to
create the new policy.

3. Press A + L  to select the Load pushbutton, or click on the
Load pushbutton with your mouse. The Quote List Dialog Box
is displayed, listing all existing policies for this client.

4. Type A + N at the same time to select the NEW pushbutton.

The Policy Definition Dialog Box is displayed. Go to the
“Filling out the Auto and Home Screens” section to continue.

To start a new quote for an existing client,

If you already have a client on your system and want to do another
quote for that client (for example, you have rated their auto and
now want to rate their home), follow the instructions below:

1. At the Client List Dialog Box, either type the name of the client
you want to load (skip to step 3), type part of the name, or
press F to move to the list of clients.

2. Press b and t to highlight the client for whom you want to
create the new policy.

3. Press A + L  to select the Load pushbutton, or click on the
Load pushbutton with your mouse. The Quote List Dialog Box
is displayed, listing all existing policies for this client.

4. Type A + N at the same time to select the NEW pushbutton.

The Policy Definition Dialog Box is displayed. Go to the “Filling
out the Auto and Home Screens” section to continue.
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Filling Out the Auto and Home Screens

Once you start a new policy, you fill out several information boxes
before you get to the Auto or Home screens. You must always
choose your line of business. Depending on your system and
preferences, you may also need to choose a state, a default set, and
plans to rate.

1. On the Policy Definition Dialog Box,

1-1.Press b and t to select the line of business you want.
1-2.Press A + O to select the OK button, or click on the OK

button with your mouse.

2. If you have more than one state of rating, the State
Determination Dialog Box is displayed.

2-1.Press b and t to highlight the state you want to rate.
2-2.Press A + O to select the OK button, or click on the OK

button with your mouse.

3. If you marked Pre-Select Defaults on the Preferences Dialog
Box, the Select Default Set Dialog Box is displayed. On this
dialog box, you choose a default set to be pre-loaded.

The choices on
your Policy
Definition
Dialog Box
vary according
to what rating
systems you
have loaded.
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To choose a default set,

3-1.Press b and t to highlight the default set you want to
load.

3-2.Press A + O to select the OK button, or click on the OK
button with your mouse.

4. If you marked Pre-Select Plans on the Preferences Dialog Box,
the Plan Selection Dialog Box is displayed.

On this dialog box, you mark in advance the plans you want to
quote:

• To mark all plans, press 6
• To mark individual plans, highlight each plan you want to

mark, and press s to mark it

To choose a default set,

3-1.Press b and t to highlight the default set you want to
load.

3-2.Press A + O to select the OK button, or click on the OK
button with your mouse.

4. If you marked Pre-Select Plans on the Preferences Dialog Box,
the Plan Selection Dialog Box is displayed.

On this dialog box, you mark in advance the plans you want to
quote:

• To mark all plans, press 6
• To mark individual plans, highlight each plan you want to

mark, and press s to mark it
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When all the plans you want to quote are marked, press A + S
to choose SELECT.

Once you fill out these information boxes, the Auto or Home
Summary Screen is then displayed. Below is a sample Auto
Summary Screen. Both Auto and Home consist of a Summary
Screen and related additional screens: for example, a coverage
screen, violation screen, scheduled personal property screen, etc.
The pushbuttons on the bottom of the screen indicate the available
other screens. You fill out the fields on each screen and then go to
another screen.

When all the plans you want to quote are marked, press A +
S to choose SELECT.

Once you fill out these information boxes, the Auto or Home
Summary Screen is then displayed. Below is a sample Auto
Summary Screen. Both Auto and Home consist of a Summary
Screen and related additional screens: for example, a coverage
screen, violation screen, scheduled personal property screen, etc.
The pushbuttons on the bottom of the screen indicate the available
other screens. You fill out the fields on each screen and then go to
another screen.



Quoting

2/5/98 53

Quoting

2/5/98 53

Filling out the Fields on a Screen

On each screen, you fill out the applicable fields and then press J
or F to go to the next field. Each field is either an edit field, an
4=Detail field, or an options field:

Type of Field What You Do

Edit Field Type the requested information

4=Detail field Press 4 or click on the field with your mouse
to bring up another dialog box in which you
enter detailed information

Options Field You can either

• Press J to accept the default
• Press s to scroll through the

options, pressing J when the option
you want to select is displayed

• Type the first letter of the option you
want to select

• Press 4 to bring up a list of options
from which you can select

If you aren’t sure how to complete a specific field, either check the
prompt line or press 1 to see the on-line field help.

The following sections cover some specific fields/types of fields
within auto and home rating.

Answering Company Questions

Company-specific question fields are marked with a colored question
mark. You can press 1 to see what company the question is for and
to get more information about how to answer the question.

Filling out the Fields on a Screen

On each screen, you fill out the applicable fields and then press J
or F to go to the next field. Each field is either an edit field, an
4=Detail field, or an options field:

Type of Field What You Do

Edit Field Type the requested information

4=Detail field Press 4 or click on the field with your mouse
to bring up another dialog box in which you
enter detailed information
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• Press s to scroll through the

options, pressing J when the option
you want to select is displayed

• Type the first letter of the option you
want to select

• Press 4 to bring up a list of options
from which you can select

If you aren’t sure how to complete a specific field, either check the
prompt line or press 1 to see the on-line field help.

The following sections cover some specific fields/types of fields
within auto and home rating.

Answering Company Questions

Company-specific question fields are marked with a colored question
mark. You can press 1 to see what company the question is for and
to get more information about how to answer the question.
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Applying an Auto/Home Discount

If you choose the same company in the Auto With and Home With
fields on the Summary Screen, an auto/home discount will be applied
for that company. If you want to apply the auto/home discount for all
companies, choose “All” in these fields.

Applying a Renewal Discount

Choose “Renewal” in the Status field on the Summary Screen.

Applying a Multi-Car Discount

If you enter more than vehicle, a multi-car discount is applied
automatically. If you enter only one vehicle but need to apply a multi-
car discount anyway, select “Yes” in the Force MultiCar field on the
Auto Summary Screen.

Applying a Loss Free Discount

Type the number of years the applicant has been loss-free in the Yrs
Loss Free field on the Summary Screen.

Adding or Viewing Family Members and Dependent Information

Press 4 in the Client Info field on the Summary Screen to open the
Client Info Box.

Applying Work Loss Coverage

Fill in the Annual Income field on the Driver Screen as well as the
Family Members and Dependents fields on the Client Info Box.

Applying an Auto/Home Discount

If you choose the same company in the Auto With and Home With
fields on the Summary Screen, an auto/home discount will be applied
for that company. If you want to apply the auto/home discount for all
companies, choose “All” in these fields.

Applying a Renewal Discount

Choose “Renewal” in the Status field on the Summary Screen.

Applying a Multi-Car Discount

If you enter more than vehicle, a multi-car discount is applied
automatically. If you enter only one vehicle but need to apply a multi-
car discount anyway, select “Yes” in the Force MultiCar field on the
Auto Summary Screen.

Applying a Loss Free Discount

Type the number of years the applicant has been loss-free in the Yrs
Loss Free field on the Summary Screen.

Adding or Viewing Family Members and Dependent Information

Press 4 in the Client Info field on the Summary Screen to open the
Client Info Box.

Applying Work Loss Coverage

Fill in the Annual Income field on the Driver Screen as well as the
Family Members and Dependents fields on the Client Info Box.
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Entering Vehicle and Driver Information

You can enter vehicle and driver information on the Coverage Screen,
or you can wait and enter vehicle information on the Vehicle Screen
and driver information on the Driver Screen.

Looking up the ISO Symbol

You can look up the ISO symbol through the VIN number or through
make and model information.

To look up the symbol through the VIN, type the VIN in the VIN
field on the Yr Make Model Dialog Box or on the Vehicle Screen.
When you press J, the symbol and other information is filled in.

To look up the symbol through the make and model, you select your
make, model, and body style from the Symbol Lookup Box.

If you have Automatic Lookups marked in the Preferences Box, the
Symbol Lookup Box displays automatically when you press J in

During symbol
lookup, the anti-
theft, air bags,
auto seatbelts,
performance,
four wheel drive,
anti-lock brakes,
and body
construction
information is
also filled in,
based on
standard
equipment.

Entering Vehicle and Driver Information

You can enter vehicle and driver information on the Coverage Screen,
or you can wait and enter vehicle information on the Vehicle Screen
and driver information on the Driver Screen.
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the Make field on the Yr Make Model Box. Otherwise, you can press
4 in the Symbol field on the Vehicle Screen.

To make a selection from this box,

1. Highlight the vehicle make: type the first character of the make to
move to that section of the list, and then press b until the make
is highlighted.

2. Press F to move to the Model section of the box.
3. Highlight the vehicle model.
4. Press F to move to the Body section of the box.
5. Highlight the body choice.
6. Type A + O to select the OK pushbutton.

Assigning Drivers

To assign drivers to vehicles, press 4 in the Driver field on the
Coverage Screen or in the Vehicle Driven field on the Driver Screen.
The Vehicle/Driver Matchup Box is displayed, and you can press
s to select who drives each vehicle the most and which vehicle
is driven the most.

.

NEW!
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Changing a Split Territory Selection

1. Press 4 in the Yr Make Model field.
2. Press b to highlight the Territory field.
3. Press 4
4. Press b to highlight the correct territory.
5. Press J.

Entering an At-Fault Accident

If you choose an AFA code on the Conviction Screen, be sure to enter
a damage amount, if applicable, or the company may not charge for
the conviction.

Applying a Non-Smokers Discount in the Home Line of Business

Select YES in the Non-Smoker field on the Summary Screen.

Applying or Viewing Endorsements in the Home Line of Business

1. Go to the Coverages Screen.
2. Press b to highlight the Miscellaneous Coverages field.
3. Press 4 to bring up the detail box.
4. Press b to highlight the Endorsements field.
5. Press 4 to view the list of available endorsements.

For more information about the endorsement, press 1 for a Help
Screen.

Changing a Split Territory Selection

1. Press 4 in the Yr Make Model field.
2. Press b to highlight the Territory field.
3. Press 4
4. Press b to highlight the correct territory.
5. Press J.

Entering an At-Fault Accident

If you choose an AFA code on the Conviction Screen, be sure to enter
a damage amount, if applicable, or the company may not charge for
the conviction.

Applying a Non-Smokers Discount in the Home Line of Business

Select YES in the Non-Smoker field on the Summary Screen.

Applying or Viewing Endorsements in the Home Line of Business

1. Go to the Coverages Screen.
2. Press b to highlight the Miscellaneous Coverages field.
3. Press 4 to bring up the detail box.
4. Press b to highlight the Endorsements field.
5. Press 4 to view the list of available endorsements.

For more information about the endorsement, press 1 for a Help
Screen.
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Adding Additional Items

There are multiple ways to add items (drivers, vehicles,  violations,
scheduled personal property, etc.).

One way to add additional items is to press C + A at the same time
(selecting the Add option from the List Menu).

If you marked the rrrrr to add item field on the Preferences Dialog
Box, you can also press r to add an item.

Finally, if you press J in the last field on a screen, the system asks
if you want to add an item or go to the next section. On the last
screen, it asks if you want to add an item or go to rating.

Deleting an Item

To delete an item (for example, remove a vehicle, driver, or item of
scheduled personal property),

1. Go to the screen for the item you want to delete.
2. Press r  to go to the column where your item is located.
3. Press C + R to remove the column.

OR

1. Go to the screen for the item you want to delete.
2. Press r  to go to the column to be deleted.
3. Press A + L  to open the List Menu.
4. Type R to select the Remove option.

Adding Additional Items
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Moving from Screen to Screen

To move from screen to screen, you can

• Press d or u
• Type A plus the hot key (letter that is a different color than

the rest of the word) of the pushbutton you want to select
• Click on the pushbutton with your mouse
• Press F until that pushbutton is highlighted and then press

J

Also, if you press J in the last field on a screen, the system asks if
you want to add an item or go to the next section. On the last screen,
it asks if you want to add an item or go to rating.

Going to Rating

Once you have entered all your client information, press 8 to go to
the Company Select Dialog Box and begin rating. Or, if you press
J in the last field on the last screen, the system asks if you want to
add an item or go to rating.

See the “Rating” chapter for further instructions.
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See the “Rating” chapter for further instructions.
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Chapter 7

Rating
To access the Company Select Dialog Box for rating, either

• Press 8
• Select RATE comparison from the Workflow Dialog Box
• Select the Company List option from the Rate Menu.

From the Company Select Dialog Box, you can

• Rate one or more companies
• Sort by lowest premium
• Print the dialog box
• Change the companies listed on the dialog box by group or

rate effective date
• View messages about the highlighted company plan
• View payment plans
• View and edit company notepads
• Review quoting information for a company
• Clear territories
• Select a company
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Rating One or More Companies
You can rate one company at a time, several companies at once, or all
companies at once.

To rate one company,

1. Highlight the company you want to rate.
2. Press J. The highlighted company is rated.

To rate more than one company but not all of them,

1. Highlight a company you want to rate.
2. Press s to mark the company.
3. Repeat steps 1 and 2 for all companies you want to rate.
4. Press A + R at the same time to select the Rate option and rate

all marked companies.

To rate all companies at once,

1. Press 6 to mark all the companies.
2. Press A + R at the same time to select RATE and rate all

marked companies.

After rating, the Code column on the Company Select Dialog Box
may display one of the following codes:

Code... Definition...

C indicates that a change was made to the input
information you entered. Usually, a limit or deductible
was changed to meet a company requirement.

I the risk is defined as ineligible to the company.
S underwriting guidelines indicate the risk should be

submitted to the company.
U the rating system is unable to rate the quote.
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2. Press J. The highlighted company is rated.

To rate more than one company but not all of them,

1. Highlight a company you want to rate.
2. Press s to mark the company.
3. Repeat steps 1 and 2 for all companies you want to rate.
4. Press A + R at the same time to select the Rate option and rate

all marked companies.

To rate all companies at once,

1. Press 6 to mark all the companies.
2. Press A + R at the same time to select RATE and rate all

marked companies.

After rating, the Code column on the Company Select Dialog Box
may display one of the following codes:

Code... Definition...

C indicates that a change was made to the input
information you entered. Usually, a limit or deductible
was changed to meet a company requirement.

I the risk is defined as ineligible to the company.
S underwriting guidelines indicate the risk should be

submitted to the company.
U the rating system is unable to rate the quote.



Quoting

2/5/98 63

Quoting

2/5/98 63

Sorting by Lowest Premium

To change the order in which companies are listed on the Company
Select Dialog Box, type A + O at the same time to select SORT.
You can switch between alphabetical order to lowest premium.

Printing the Company Select Dialog Box

To print a copy of the Company Select Dialog Box, type A + P at
the same time to select PRINT.

Changing the Listed Companies

You can change the companies listed on your Company Select Dialog
Box by group or rate effective date.

By Group

You can use the Group option to change, by category, the companies
listed on the Company Select Dialog Box. For example, you could
list only Standard companies, or only Standard and Preferred
companies.

To change the listed companies,

1. Press A + G at the same time to select the Group pushbutton.
The Groups Dialog Box is displayed, listing categories of
companies.

You can also
create your
own groups.
See the
Advanced
Options section
for more
information
about this
feature.
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2. Groups that you want displayed on the list must be marked. To
mark and unmark companies, you can

• Press 5 to unmark all the groups
• Press 6 to mark all the groups
• Press s to mark or unmark the highlighted group

3. Once the groups you want are marked, press A + O to select
the OK pushbutton. You return to the Company Select Dialog
Box, which lists only companies in the groups you marked.

By Date

When the Company Select Dialog Box first displays, it lists the most
current rate dates for your companies. To view all available rates for
your companies, type A + A to select the ALLRTS button.

To return to the most current rates only, press A + E to select the
NEWRTS button.

2. Groups that you want displayed on the list must be marked. To
mark and unmark companies, you can

• Press 5 to unmark all the groups
• Press 6 to mark all the groups
• Press s to mark or unmark the highlighted group

3. Once the groups you want are marked, press A + O to select
the OK pushbutton. You return to the Company Select Dialog
Box, which lists only companies in the groups you marked.

By Date

When the Company Select Dialog Box first displays, it lists the most
current rate dates for your companies. To view all available rates for
your companies, type A + A to select the ALLRTS button.

To return to the most current rates only, press A + E to select the
NEWRTS button.

NEW!NEW!
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Viewing Messages about the Company Plan
To view messages for the highlighted company, type A + M  at the
same time to select MESSAGE. The Quote Messages Dialog Box is
displayed.

At the Quote Messages Screen, you can press A + X to return to
the Company Plan Dialog Box, A + P to print the messages, or
A + R to refresh and update the box so it only displays messages
for your current quote.

NEW!

Viewing Messages about the Company Plan
To view messages for the highlighted company, type A + M  at the
same time to select MESSAGE. The Quote Messages Dialog Box is
displayed.

At the Quote Messages Screen, you can press A + X to return to
the Company Plan Dialog Box, A + P to print the messages, or
A + R to refresh and update the box so it only displays messages
for your current quote.

NEW!
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Viewing Payment Plans
To view company payment plans, type A + Y at the same time to
select PAYPLAN . The Payment Plans Dialog Box is displayed.

To change the order in which the payment plans are listed,

Press To Select this Order

A + D Down-payment
A + Y Payment Amount
A + T Total Premium

You can also

• Select a company - A + S
• Print the list of payment plans - A + P
• View the messages - A + M
• View payment plan details - A + E

To return to the Company Select Dialog Box, press E or type A
+ C to select CANCEL.

Viewing Payment Plans
To view company payment plans, type A + Y at the same time to
select PAYPLAN . The Payment Plans Dialog Box is displayed.

To change the order in which the payment plans are listed,
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NEW!NEW!
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Viewing and Editing Company Notepads
The company notepads are a place where you can keep underwriting
notes and reminders about each company. To view or edit a company
notepad,

1. Highlight the company whose notepad you want to view.
2. Type A + N at the same time to select NOTEPAD. The

notepad for the highlighted company is displayed.

3. If you have notes to add to the notepad, type them in the User
notes section.

4. When you are done viewing/editing the notepad, type A + S to
save the notes and return to the Company Select Dialog Box.

You can also clear the notes by typing A + L  to select the Clear
pushbutton.

If a company has notes in the Notepad, that company is marked with
an asterisk on the Company Select Dialog Box.

Viewing and Editing Company Notepads
The company notepads are a place where you can keep underwriting
notes and reminders about each company. To view or edit a company
notepad,

1. Highlight the company whose notepad you want to view.
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4. When you are done viewing/editing the notepad, type A + S to
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If a company has notes in the Notepad, that company is marked with
an asterisk on the Company Select Dialog Box.

NEW! NEW!
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Reviewing Quoting Information

You can review detailed quote information from the Company Select
Dialog Box before selecting a company:

1. Press b or t to arrow to the company you want to review.
2. Press A + V at the same time to choose the Review pushbutton.

The first Quote Review Screen for the selected company is
displayed.

You can press u and d to move between the Quote Review
Screens. You can also press A + N to move to the review screens
for the next company, A + P to move to the review screens for the
previous company, or A + S to select a company and return to the
coverage screens.See the

“Selecting a
Company“
section for more
information
about selecting
a company.

Reviewing Quoting Information

You can review detailed quote information from the Company Select
Dialog Box before selecting a company:

1. Press b or t to arrow to the company you want to review.
2. Press A + V at the same time to choose the Review pushbutton.

The first Quote Review Screen for the selected company is
displayed.

You can press u and d to move between the Quote Review
Screens. You can also press A + N to move to the review screens
for the next company, A + P to move to the review screens for the
previous company, or A + S to select a company and return to the
coverage screens.See the

“Selecting a
Company“
section for more
information
about selecting
a company.

NEW!NEW!
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Clearing Territories

If a company you rate splits your zip code into two or more
territories, you select a territory during rating. If you later need to
change the selection, type A + T to choose the TERR pushbutton.
All territory selections will be cleared, so you can select different
territories.

Selecting a Company

Once you have decided which company to place the client with, you
need to select that company. When you quote, your input information
(such as limits and deductibles) may be changed to meet a company
requirement. Once you select a company, those changes are
transferred to the input screens.

To select a company,

1. Highlight the company you want to select.
2. Type A + S at the same time to choose SELECT. You return to

the Coverage Screen, which now lists the company and premium
information.

You can also
press E to go
back to the
input screens
without
selecting a
company.

Clearing Territories

If a company you rate splits your zip code into two or more
territories, you select a territory during rating. If you later need to
change the selection, type A + T to choose the TERR pushbutton.
All territory selections will be cleared, so you can select different
territories.

Selecting a Company

Once you have decided which company to place the client with, you
need to select that company. When you quote, your input information
(such as limits and deductibles) may be changed to meet a company
requirement. Once you select a company, those changes are
transferred to the input screens.

To select a company,

1. Highlight the company you want to select.
2. Type A + S at the same time to choose SELECT. You return to

the Coverage Screen, which now lists the company and premium
information.

You can also
press E to go
back to the
input screens
without
selecting a
company.

NEW! NEW!
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If you later want to...

• modify your original input, choose Clear Company from the
Rate Menu. Any changes from this point will become part of the
original input.

• change to the detail information for another company, press
8. The Quote Data Selection Screen is displayed.

To return to your original input, type A + R to choose the
RESTORE button. Any changes you made since you last quoted
will be discarded. Choose this option to view detailed information
for another company.

To keep the input as it currently is on the input screens, type  A
+ C to choose the CURRENT button. All changes, including any
you made since you last quoted, will be retained.

You can also press s to mark the Make Current the Original
field. If you mark this field, the quote as it currently is on the input
screen replaces the original quote information permanently. If you
later restore, the quote returns to this point rather than to what you
originally entered.

Viewing Class Codes, Territory, and Points

To view class codes, territory, and points after selecting a company,
press 4 in the Yr Make Model field on the Coverages Screen.

If you make
changes to the
input screen
that you want to
save, choose
Clear Company
from the Rate
Menu before
you press 8.

If you later want to...

• modify your original input, choose Clear Company from the
Rate Menu. Any changes from this point will become part of the
original input.

• change to the detail information for another company, press
8. The Quote Data Selection Screen is displayed.

To return to your original input, type A + R to choose the
RESTORE button. Any changes you made since you last quoted
will be discarded. Choose this option to view detailed information
for another company.

To keep the input as it currently is on the input screens, type  A
+ C to choose the CURRENT button. All changes, including any
you made since you last quoted, will be retained.

You can also press s to mark the Make Current the Original
field. If you mark this field, the quote as it currently is on the input
screen replaces the original quote information permanently. If you
later restore, the quote returns to this point rather than to what you
originally entered.

Viewing Class Codes, Territory, and Points

To view class codes, territory, and points after selecting a company,
press 4 in the Yr Make Model field on the Coverages Screen.

If you make
changes to the
input screen
that you want to
save, choose
Clear Company
from the Rate
Menu before
you press 8.
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Chapter 8

Entering Group Factors
To enter factors for your groups,

1. Choose the Group Factors option from the Utilities Menu. The
Plan Factor Selection Dialog Box is displayed, listing companies
that have plan factors.

2. Highlight the company for which you want to add factors.
3. Press A + O to select the OK button. The list of groups for the

selected company is displayed.

Chapter 8

Entering Group Factors
To enter factors for your groups,

1. Choose the Group Factors option from the Utilities Menu. The
Plan Factor Selection Dialog Box is displayed, listing companies
that have plan factors.
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selected company is displayed.
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4. Type A + A to select the ADD pushbutton. The Group and
Factors Dialog Box is displayed.

5. Type the name of the group and the auto and home factors,
pressing F to move from field to field.

6. Press  A + O to select the OK pushbutton. You return to the
group listing.

7. When you are done adding groups, type A + O to select the
OK pushbutton and exit the group listing.

To edit group factors,

1. Choose the Group Factors option from the Utilities Menu. The
Plan Factor Selection Dialog Box is displayed, listing companies
that have plan factors.

2. Highlight the company for which you want to add factors.
3. Press J. The list of groups for the selected company is

displayed.
4. Highlight the plan name for which you want to edit factors.
5. Press J. The Group and Factors Dialog Box is displayed.
6. Update the name of the group and the auto and home factors as

needed, pressing F to move from field to field.
7. Press  A + O to select the OK pushbutton. You return to the

group listing.
8. When you are done, type A + O to select the OK pushbutton

and exit the group listing.

4. Type A + A to select the ADD pushbutton. The Group and
Factors Dialog Box is displayed.

5. Type the name of the group and the auto and home factors,
pressing F to move from field to field.

6. Press  A + O to select the OK pushbutton. You return to the
group listing.

7. When you are done adding groups, type A + O to select the
OK pushbutton and exit the group listing.

To edit group factors,

1. Choose the Group Factors option from the Utilities Menu. The
Plan Factor Selection Dialog Box is displayed, listing companies
that have plan factors.

2. Highlight the company for which you want to add factors.
3. Press J. The list of groups for the selected company is
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4. Highlight the plan name for which you want to edit factors.
5. Press J. The Group and Factors Dialog Box is displayed.
6. Update the name of the group and the auto and home factors as

needed, pressing F to move from field to field.
7. Press  A + O to select the OK pushbutton. You return to the

group listing.
8. When you are done, type A + O to select the OK pushbutton

and exit the group listing.
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Chapter 9

Editing a Quote
If you need to make changes to your policy information, you can edit,
add, and remove items on the coverage screens, or you can do a
quick-edit  using the Quick-Quote screens.

Editing Client Information

After rating, you may need to change information that you entered.
For example, you may need to adjust limits and deductibles. To edit
client information,

1. Go to the screen for the item you want to edit.
2. Move the highlight to the item to be changed.
3. Depending on the field you are editing, you either type the new

information or press s, the first letter, or 4 to select an
option.

Keep in mind that, if you marked the Automatic Rate Calculation
option in the Preferences Dialog Box, the premium re-calculates with
every change you make. To save time when making changes, press
4 and select your new option from the menu. If you use s to
change options, the system re-rates for every selection.

Chapter 9
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Adding an Item

To add an item to your quote,

1. Go to the line of business for the item you want to add.
2. Type C + A at the same time to select the Add option from the

List Menu .

Copying Coverage Information Across a Risk

When you add a new item, the coverage from the previous column is
automatically copied. To copy coverage information from another
column or to make later changes, you can use the Copy option. You
can copy one field or the entire column.

1. Move the highlight to the field or column from which you want to
copy. For example, if you are copying from Vehicle 1 to Vehicle
2, move the highlight to the Vehicle 1 column.

2. Press C + C. The Set Value Dialog Box is displayed.

Adding an Item

To add an item to your quote,

1. Go to the line of business for the item you want to add.
2. Type C + A at the same time to select the Add option from the

List Menu .

Copying Coverage Information Across a Risk

When you add a new item, the coverage from the previous column is
automatically copied. To copy coverage information from another
column or to make later changes, you can use the Copy option. You
can copy one field or the entire column.

1. Move the highlight to the field or column from which you want to
copy. For example, if you are copying from Vehicle 1 to Vehicle
2, move the highlight to the Vehicle 1 column.

2. Press C + C. The Set Value Dialog Box is displayed.
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3. Press b and t to indicate if you want to copy the highlighted
field only, all coverage fields, or all fields.

4. Press F to the Target Columns section.
5. Press b and t to move through the list of columns, pressing

s to mark any column to which you want the coverage
copied.

6. Press A + O to select the OK button. The coverage information
is copied.

Removing an Item

To delete an item from your quote,

1. Go to the line of business for the item you want to delete.
2. If the line of business has more than one item, move the cursor to

the item you want to delete.
3. Type C + R at the same time to select the Remove option from

the List Menu.
4. Press J to confirm that you want to delete this item.

Doing a Quick Edit

If you want to edit a quote using the Quick-Quote screens instead of
the coverage screens,

1. Select the QUICK-EDIT existing policy option from the
Workflow Dialog Box. The Quick Quote Setup Dialog Box for
the loaded client is displayed.

2. Make any necessary changes to the information on the quick-
quote screens.

3. Press b and t to indicate if you want to copy the highlighted
field only, all coverage fields, or all fields.

4. Press F to the Target Columns section.
5. Press b and t to move through the list of columns, pressing

s to mark any column to which you want the coverage
copied.

6. Press A + O to select the OK button. The coverage information
is copied.

Removing an Item

To delete an item from your quote,

1. Go to the line of business for the item you want to delete.
2. If the line of business has more than one item, move the cursor to

the item you want to delete.
3. Type C + R at the same time to select the Remove option from

the List Menu.
4. Press J to confirm that you want to delete this item.

Doing a Quick Edit

If you want to edit a quote using the Quick-Quote screens instead of
the coverage screens,

1. Select the QUICK-EDIT existing policy option from the
Workflow Dialog Box. The Quick Quote Setup Dialog Box for
the loaded client is displayed.

2. Make any necessary changes to the information on the quick-
quote screens.

NEW! NEW!
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Chapter 10

Viewing Other Premiums
The Shopper and Shop Field options allow you to view alternative
premiums, and the Pro-Rate option lets you calculate premiums for a
specific time period.

Using the Shopper Option
The Shopper option is only available in the Auto line of business and
from the Auto Coverage Screen. It allows you to view premiums for
other limits and deductibles. You must rate before you use Shopper.

1. At the Auto Coverage Screen, select Shopper from the Rate
Menu. The Shopper Screen is displayed.

2. Press A + the hot key (L for liability or O for OTC/Coll) to
select liability limits or deductibles. The Auto Shopper Definition
Dialog Box is displayed.

Chapter 10
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3. Mark the options for which you want to see premiums. You can
shop up to seven options:

3-1.Press b and t to move through the list of options.
3-2.Press s to mark or unmark an option. You can also

press 5 to mark all options or 6 to unmark all options.

4. Press J. The Shopping Dialog Box is displayed, displaying a
table of premiums for the options you selected.

If you mark
more than
seven options,
the first seven
you mark will
be shopped.

If you mark
more than
seven options,
the first seven
you mark will
be shopped.

3. Mark the options for which you want to see premiums. You can
shop up to seven options:

3-1.Press b and t to move through the list of options.
3-2.Press s to mark or unmark an option. You can also

press 5 to mark all options or 6 to unmark all options.

4. Press J. The Shopping Dialog Box is displayed, displaying a
table of premiums for the options you selected.
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5. Use the table below to determine your next step:

If you want to... Then...

Select a different 1. Press b and t to highlight
premium the premium you want.

2. Type A + S at the same
time to choose SELECT.

See the premiums for Type A + N to go to the next
another vehicle vehicle or A + V to go to the

previous vehicle

Leave the Shopping Press  A + O to select OK
Dialog Box

Print the screen Press A + P to select PRINT

Using the Field Shopper Option

The Field Shopper lets you view premium changes caused by any
field that has options. You must rate and select a company before you
use Field Shopper.

To use the Field Shopper to compare prices,

1. Go to a field for which coverage options are available.
2. Press C + 4 to select Shop Field from the Rate Menu. The

Coverage Shopper Dialog Box is displayed, with all options for
the field marked.

5. Use the table below to determine your next step:

If you want to... Then...

Select a different 1. Press b and t to highlight
premium the premium you want.

2. Type A + S at the same
time to choose SELECT.

See the premiums for Type A + N to go to the next
another vehicle vehicle or A + V to go to the

previous vehicle

Leave the Shopping Press  A + O to select OK
Dialog Box

Print the screen Press A + P to select PRINT

Using the Field Shopper Option

The Field Shopper lets you view premium changes caused by any
field that has options. You must rate and select a company before you
use Field Shopper.

To use the Field Shopper to compare prices,

1. Go to a field for which coverage options are available.
2. Press C + 4 to select Shop Field from the Rate Menu. The

Coverage Shopper Dialog Box is displayed, with all options for
the field marked.
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3. Press s to mark and unmark options so only the options
for which you want to see premiums are marked.

4. Press A + S to select the SHOP pushbutton. The Coverage
Shopper Matrix Dialog Box is displayed, listing the premium for
each option and the difference between it and the currently
selected premium. You can press your arrow keys to move
around the box, and the premium difference will update as you
move from field to field.

3. Press s to mark and unmark options so only the options
for which you want to see premiums are marked.

4. Press A + S to select the SHOP pushbutton. The Coverage
Shopper Matrix Dialog Box is displayed, listing the premium for
each option and the difference between it and the currently
selected premium. You can press your arrow keys to move
around the box, and the premium difference will update as you
move from field to field.
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5. Use the table below to determine your next step:

If you want to... Then...

Select an option 1. Press b and t to highlight it.
2. Press A + S to select the SELECT

pushbutton. You return to the updated
Rating Summary Screen.

Shop different 1. Press A + R to select RESHOP
options 2. Repeat steps 3-5.

Exit the Shopper Press E or A + C to cancel the shopping

Print the screen Press A + P to select PRINT

Calculating a Pro-Rate

You can calculate a pro-rated premium before or after quoting.

1. Choose Pro-Rate from the Utilities Menu. The Pro-Rate
Calculator Box is displayed.

 

2. If you have quoted, the Beginning Date defaults to the effective
date of the policy. Otherwise, it defaults to the current date. If
you need a different date, type it in MMDDYY format.

3. Press F to move to the Ending Date field.

5. Use the table below to determine your next step:

If you want to... Then...

Select an option 1. Press b and t to highlight it.
2. Press A + S to select the SELECT

pushbutton. You return to the updated
Rating Summary Screen.

Shop different 1. Press A + R to select RESHOP
options 2. Repeat steps 3-5.

Exit the Shopper Press E or A + C to cancel the shopping

Print the screen Press A + P to select PRINT

Calculating a Pro-Rate

You can calculate a pro-rated premium before or after quoting.

1. Choose Pro-Rate from the Utilities Menu. The Pro-Rate
Calculator Box is displayed.

2. If you have quoted, the Beginning Date defaults to the effective
date of the policy. Otherwise, it defaults to the current date. If
you need a different date, type it in MMDDYY format.

3. Press F to move to the Ending Date field.
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4. Type the ending date of the time period in MMDDYY format.
5. Press F to move to the Premium field.
6. If you have already quoted, the premium is displayed in the

premium field. Otherwise, type in the premium amount.
7. Press A + P to select the ProRate pushbutton. The premium is

displayed in the Pro-Rated Premium field and the number of days
in the time period is displayed in the Number of Days field.

8. When you are done calculating the pro-rate, press E or type
A + C to close the Pro-Rate Calculator Dialog Box.

4. Type the ending date of the time period in MMDDYY format.
5. Press F to move to the Premium field.
6. If you have already quoted, the premium is displayed in the

premium field. Otherwise, type in the premium amount.
7. Press A + P to select the ProRate pushbutton. The premium is

displayed in the Pro-Rated Premium field and the number of days
in the time period is displayed in the Number of Days field.

8. When you are done calculating the pro-rate, press E or type
A + C to close the Pro-Rate Calculator Dialog Box.
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Chapter 11

Viewing a Schedule and Summary
You can view schedules for each detail item and a quick summary of
the overall line of business.

Schedule

 From the auto or home detail screens (not the Summary Screens),
you can view schedules. To view a schedule,

1. Go to the detail screen for which you want to see the schedule.
For example, to see a Vehicle Schedule, go to the Vehicle Screen.
To see an SPP Item Schedule, go to the SPP Screen.

2. Type A + L  to open the List Menu.
3. Type H to select the Schedule option. The schedule is displayed.
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4. If you want to print the schedule,

4-1.Type A + P to select the PRINT button. The Printer
Selection Dialog Box is displayed.

4-2.Press b until the printer you want is highlighted.
4-3.If you need to change the Form Feed or Print to Queue

fields, press F to move to the appropriate field and then
press s to mark or unmark it.

4-4.Type A + P to select the PRINT button. The schedule
prints and you return to the detail screen.

If you do not want to print the schedule, press A + O to select the
OK button when you are done viewing the schedule.

Quick Summary
To view a quick summary, press 6 or select the Quick Summary
option from the List Menu.

You can press u and d to move between the Quote Review
Screens.

4. If you want to print the schedule,

4-1.Type A + P to select the PRINT button. The Printer
Selection Dialog Box is displayed.

4-2.Press b until the printer you want is highlighted.
4-3.If you need to change the Form Feed or Print to Queue

fields, press F to move to the appropriate field and then
press s to mark or unmark it.

4-4.Type A + P to select the PRINT button. The schedule
prints and you return to the detail screen.

If you do not want to print the schedule, press A + O to select the
OK button when you are done viewing the schedule.

Quick Summary
To view a quick summary, press 6 or select the Quick Summary
option from the List Menu.

You can press u and d to move between the Quote Review
Screens.

NEW!NEW!
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Chapter 12

Saving a Quote
To save a quote, type C + S at the same time, or select the Save
option from the File Menu.

If you are saving the quote for the first time,

the Quote Description Box is displayed.

1. Type a short description of the quote.
2. Type A + O to select the OK pushbutton.

If you have saved this quote before,

a box displays asking if you want to replace the existing quote or
make a new copy of the quote

1. If you want to replace the existing quote, type R to choose the
REPLACE pushbutton.

If you want to make a copy, type M  to choose the MAKE COPY
pushbutton.

Chapter 12

Saving a Quote
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option from the File Menu.
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REPLACE pushbutton.

If you want to make a copy, type M  to choose the MAKE
COPY pushbutton.
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2. If you chose to make a copy, the Quote Description Dialog Box
is displayed.

3. Type a description of the quote.
4. Type A + O to select the OK pushbutton.

Using Save As

With the Save As option, you can save multiple copies of your
quotes. For example, you may want to save the same quote with
different companies or with different coverage information.

To use Save As,

1. Select the Save As option from the File Menu. The Quote
Description Dialog Box is displayed.

2. Type a description of the quote.
3. Type A + O to select the OK pushbutton.

Changing the Quote Description

To change the description of your quote, choose the Quote
Description option from the File Menu and type the new description.

2. If you chose to make a copy, the Quote Description Dialog Box
is displayed.

3. Type a description of the quote.
4. Type A + O to select the OK pushbutton.

Using Save As

With the Save As option, you can save multiple copies of your
quotes. For example, you may want to save the same quote with
different companies or with different coverage information.

To use Save As,

1. Select the Save As option from the File Menu. The Quote
Description Dialog Box is displayed.

2. Type a description of the quote.
3. Type A + O to select the OK pushbutton.

Changing the Quote Description

To change the description of your quote, choose the Quote
Description option from the File Menu and type the new description.
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Chapter 13

Loading and Deleting Clients
You load and delete clients and policies from the Client List and the
Quote List Dialog Boxes. This chapter shows you how to

• Access the Client List Dialog Box
• Search for a Client
• Load a Client and Quote
• Edit a Quote Description and Status
• Transfer a Quote to another AMS Rating System
• Delete a Client and Quote
• Delete a Quote Only

Accessing the Client List Dialog Box

You access the Client List Dialog Box by selecting either

• Load an Existing Client from the Workflow Dialog Box
OR

• Open from the File MenuYou can also
press C  + O
to access the
Client List
Dialog Box.

You can also
press C  + O
to access the
Client List
Dialog Box.
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Searching for a Client

There are several ways to find the name of a client on the Client List
Dialog Box.

Option 1: Highlight the Name

If your client list is not very long, just press F to move to the list of
clients and then press b and t to highlight the client you want to
load.

Option 2: Name Beginning With Field

If you have a lot of names in your client list, you may wish to use the
Name Beginning With field to limit the names displayed:

1. Type the name of the client (or part of the name) in the Name
Beginning With field.

2. Press J to display only names that match what you typed in
step 1.

3. If  necessary, press F to move to the list of clients and then
press b and t to highlight the client you want to load.

Option 3: Search Box

If you want to search by the effective date, expiration date, or phone
number rather than by the client name, you can use the Search
function:

1. On the Client List Dialog Box, press A + R to select the
SEARCH pushbutton. The Client Search Dialog Box is
displayed.

2. Press s to choose Effective Date, Expiration Date, or
Phone Number as the search factor.

3. Press F.
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4. Type the beginning date or phone number for your search.
5. Type the ending date or phone number for your search.

6. Press J to begin the search. The Client Search Dialog Box
show all clients  who have effective/expiration dates or phone
numbers between your beginning and ending information.

7. Press b and t to highlight the client you want to select.
8. Press A + S to select the SELECT pushbutton. You return to

the Client List Dialog Box. The client you selected on the Client
Search Dialog Box is highlighted.

Loading a Client and Quote

To load a client and quote,

1. Highlight the client you want to load.
2. Press A + L  to select the LOAD pushbutton. The Quote List

Dialog Box is displayed, listing all policies for this client.

See the
Searching for a
Client section
for instructions
on how to
highlight a
client.

4. Type the beginning date or phone number for your search.
5. Type the ending date or phone number for your search.

6. Press J to begin the search. The Client Search Dialog Box
show all clients  who have effective/expiration dates or phone
numbers between your beginning and ending information.

7. Press b and t to highlight the client you want to select.
8. Press A + S to select the SELECT pushbutton. You return to

the Client List Dialog Box. The client you selected on the Client
Search Dialog Box is highlighted.

Loading a Client and Quote

To load a client and quote,

1. Highlight the client you want to load.
2. Press A + L  to select the LOAD pushbutton. The Quote List

Dialog Box is displayed, listing all policies for this client.

See the
Searching for a
Client section
for instructions
on how to
highlight a
client.
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3. Press b and t to highlight the quote you want to load.
4. Press A + L  to select the LOAD pushbutton. The Rating

Summary Screen for this client and quote is displayed.

To return to the Client List Dialog Box and select a different
client, press E.

Editing A Quote Description and Status

The Quote List Dialog Box includes quote description and status
fields, which you can edit:

1. Highlight the client you want to edit.
2. Press A + L  to select the LOAD pushbutton. The Quote List

Dialog Box is displayed, listing all policies for this client.
3. Press b and t to highlight the quote you want to edit.
4. Press A + E to select the EDIT pushbutton. The Quote Edit

Dialog Box is displayed.
5. The Quote Description field displays the saved company. If you

want to change this entry, type a new description.

When you save a quote, the Quote Description
field changes back to display the company name.

See the
Searching for a
Client section
for instructions
on how to
highlight a
client.

3. Press b and t to highlight the quote you want to load.
4. Press A + L  to select the LOAD pushbutton. The Rating

Summary Screen for this client and quote is displayed.

To return to the Client List Dialog Box and select a different
client, press E.

Editing A Quote Description and Status

The Quote List Dialog Box includes quote description and status
fields, which you can edit:

1. Highlight the client you want to edit.
2. Press A + L  to select the LOAD pushbutton. The Quote List

Dialog Box is displayed, listing all policies for this client.
3. Press b and t to highlight the quote you want to edit.
4. Press A + E to select the EDIT pushbutton. The Quote Edit

Dialog Box is displayed.
5. The Quote Description field displays the saved company. If you

want to change this entry, type a new description.

When you save a quote, the Quote Description
field changes back to display the company name.

See the
Searching for a
Client section
for instructions
on how to
highlight a
client.
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6. Press F to move to the Status field.
7. Type a status description.
8. Press A + O to select the OK pushbutton. You return to the

Quote List Dialog Box.

Transferring a Quote to another AMS Rating
System

If you have other AMS rating systems, such as company-specific
systems, you can transfer quotes saved in this comparative rating
system to another system:

1. Highlight the client you want to transfer.
2. Press A + L  to select the LOAD pushbutton. The Quote List

Dialog Box is displayed, listing all policies for this client.
3. Press b and t to highlight the quote you want to transfer.
4. Press A + T to select the TRANSFER pushbutton.
5. If you have more than one system to which you can transfer, a

list of options is displayed. Press b and t to highlight the
system to which you want to transfer.

See the
Searching for a
Client section
for instructions
on how to
highlight a
client.

6. Press F to move to the Status field.
7. Type a status description.
8. Press A + O to select the OK pushbutton. You return to the

Quote List Dialog Box.

Transferring a Quote to another AMS Rating
System

If you have other AMS rating systems, such as company-specific
systems, you can transfer quotes saved in this comparative rating
system to another system:

1. Highlight the client you want to transfer.
2. Press A + L  to select the LOAD pushbutton. The Quote List

Dialog Box is displayed, listing all policies for this client.
3. Press b and t to highlight the quote you want to transfer.
4. Press A + T to select the TRANSFER pushbutton.
5. If you have more than one system to which you can transfer, a

list of options is displayed. Press b and t to highlight the
system to which you want to transfer.

See the
Searching for a
Client section
for instructions
on how to
highlight a
client.
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6. Press J. A verification box is displayed.
7. Press J again. The new rating system opens, with all quoting

information transferred.

Deleting a Client and Quote

To delete a client,

1. On the Client List Dialog Box, highlight the client you want to
delete.

2. Type A + D at the same time to select the Delete pushbutton.
3. Confirm or cancel the deletion:

To confirm the deletion, just press J.

To cancel the deletion, type A + N at the same time to select
the No pushbutton.

Deleting a Quote Only

To delete a quote but not the client,

1. On the Client List Dialog Box, highlight the client whose quote
you want to delete.

2. Press J. The Quote List Dialog Box appears, listing all quotes
for this client.

3. Press b and t to highlight the quote you want to delete.
4. Type A + D at the same time to select the Delete pushbutton.
5. Confirm or cancel the deletion:

To confirm the deletion, just press J.

To cancel the deletion, type A + N at the same time to select
the No pushbutton.

See the
Searching for a
Client section
for instructions
on how to
highlight a
client.

See the
Searching for a
Client section
for instructions
on how to
highlight a
client.
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Chapter 14

Printing Quotes and Letters
You can print quotes and letters with your rating system.

Quotes
To print a quote,

1. Type A + F at the same time to select and open the File Menu.
2. Type P to select the Print option. The Print Sub-Menu displays.
3. Type Q to select the Quote option.
4. If you have made changes since last rating, a box displays asking

if you want to re-rate before continuing. Press either J to re-
rate or A + N to continue without re-rating.

5. If the Print Optional Ded field on the Preferences Dialog Box is
marked Ask, then a box displays asking if you want to print
optional deductibles. Press either J to print the optional
deductibles or A + N to if you don’t want to print them.

The Print Quote Dialog Box is displayed.

You can also
press 9 to
print a quote.
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NEW! NEW!
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You can edit
and add
producers and
agencies
through the
Setup Menu  on
the AMS
Rating Menu .
See the Getting
Started section
for instructions.

These options
vary depending
on the type of
printer and the
selected form,
so all the
options may not
be accessible
on your screen.

Whenever all the fields display the correct
information, skip to step 17. If all the default
options are correct, you can skip to step 17 now.

6. Press b and t to highlight the document you want to print.
7. Press F.
8. If more than one printer is listed, press b and t to highlight the

printer on which you want to print.
9. Press F.
10. In the Print Heading, Print to Queue, Enhance Printout, and

Non-Graphical Laser Print fields, press s to mark or
unmark the appropriate options:

• Mark Print Heading if you want the agency’s name and
address to appear at the top of the printout

• Mark Print to Queue if you want the printout sent to the
printer queue for later printing, rather than printed
immediately

• Mark Enhance Printout if you are printing on a dot
matrix printer and need final rather than draft quality

• Mark Non-Graphical Laser Print if you are printing on
a laser printer and want draft rather than final quality

11. Press F.
12. Type the number of copies you want to print.
13. Press F.
14. If the default producer option is not correct, press s, the

first letter, or 4 to select another option.
15. Press F.
16. If the default agency option is not correct, press s, the first

letter, or 4 to select another option.
17. If all the information is now correct, press J. The quote prints

to the selected printer.
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Letters

Your rating program includes several letters that you can use as is.
You can also use the Editor to edit these letters or write your own
letters. See the Advanced Functions section for instructions on
editing and writing letters. This section covers how to print a letter.

When you print a letter, your client information is automatically input
into the letter, so you do not have to re-enter it. To print a letter,

1. Type A + F at the same time to select and open the File Menu.
2. Type P to select the Print option. The Print Sub-Menu appears.
3. Type L  to select the Letter option. The Print Letter Dialog Box is

displayed.

Whenever all the fields display the correct
information, skip to step 14. If all the default
options are correct, you can skip to step 14 now.

4. Press b and t to highlight the letter you want to print.
5. Press F.
6. If more than one printer is listed, press b and t to highlight the

printer on which you want to print.

Letters

Your rating program includes several letters that you can use as is.
You can also use the Editor to edit these letters or write your own
letters. See the Advanced Functions section for instructions on
editing and writing letters. This section covers how to print a letter.

When you print a letter, your client information is automatically input
into the letter, so you do not have to re-enter it. To print a letter,

1. Type A + F at the same time to select and open the File Menu.
2. Type P to select the Print option. The Print Sub-Menu appears.
3. Type L  to select the Letter option. The Print Letter Dialog Box is

displayed.

Whenever all the fields display the correct
information, skip to step 14. If all the default
options are correct, you can skip to step 14 now.

4. Press b and t to highlight the letter you want to print.
5. Press F.
6. If more than one printer is listed, press b and t to highlight the

printer on which you want to print.
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7. Press F.
8. If you want to send the letter to the queue for later printing rather

than printing it now, press s to mark Print to Queue.
9. Press F.
10. Type the number of copies you want to print.
11. Press F.
12. Type the number of lines to print on each page. For a laser

printer, this field should be 60. For other printers, it should be
66.

13. If the default producer option is not correct, press s, the
first letter, or 4 to select another option.

14. Press F.
15. If the default agency option is not correct, press s, the first

letter, or 4 to select another option.
16. If all the information is now correct, press A + P to select the

PRINT pushbutton. The letter prints to the selected printer.

Using the Queue

To print items that you have sent to the queue,

1. Type A + F at the same time to select and open the File Menu.
2. Type P to select the Print option. The Print Sub-Menu appears.
3. Type U to select the Queue option. A box is displayed asking if

you want to print or delete the queue
4. Type P to print or D to delete.
5. If you chose to print the queue, a box is displayed asking if you

want to be prompted between print jobs. Type Y for yes or N for
no.

Printing begins.

If you said Yes to prompting between jobs, you will be asked
before each item in the queue whether or not to print it.

7. Press F.
8. If you want to send the letter to the queue for later printing rather

than printing it now, press s to mark Print to Queue.
9. Press F.
10. Type the number of copies you want to print.
11. Press F.
12. Type the number of lines to print on each page. For a laser

printer, this field should be 60. For other printers, it should be
66.

13. If the default producer option is not correct, press s, the
first letter, or 4 to select another option.

14. Press F.
15. If the default agency option is not correct, press s, the first

letter, or 4 to select another option.
16. If all the information is now correct, press A + P to select the

PRINT pushbutton. The letter prints to the selected printer.

Using the Queue

To print items that you have sent to the queue,

1. Type A + F at the same time to select and open the File Menu.
2. Type P to select the Print option. The Print Sub-Menu appears.
3. Type U to select the Queue option. A box is displayed asking if

you want to print or delete the queue
4. Type P to print or D to delete.
5. If you chose to print the queue, a box is displayed asking if you

want to be prompted between print jobs. Type Y for yes or N for
no.

Printing begins.

If you said Yes to prompting between jobs, you will be asked
before each item in the queue whether or not to print it.
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6. A box is displayed asking if you want to delete the queue. Type
Y for yes or N for no.

7.  If you said Yes, a verification box is displayed double-checking
that you want to delete the queue. Type Y to delete the queue or
N to save it.

6. A box is displayed asking if you want to delete the queue. Type
Y for yes or N for no.

7.  If you said Yes, a verification box is displayed double-checking
that you want to delete the queue. Type Y to delete the queue or
N to save it.
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Chapter 15

Completing and Printing ACORDS
This chapter covers

• Filling out an ACORD form
• Printing an ACORD form
• Saving an ACORD form
• Exiting the ACORD Form Processor

Filling Out an ACORD Form
To fill out an ACORD form,

1. Type A + F at the same time to open the File Menu.
2. Type F to select the Forms option.
3. If you have made changes since last rating, a box displays asking

if you want to re-rate before continuing. Press either J to re-
rate or A + N to continue without re-rating.

The Forms Processor Action Bar appears, and an ACORD form
is loaded. Some fields will be pre-filled with information from the
coverage screens.
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4. If this is the form you want to fill out, you can begin filling it out
immediately. For help figuring out how to fill in a field, check the
prompt line at the bottom of the screen.

The following keys will help you fill out the form:

Press… To…

J Move from field to field

9 or d Move to the next page of the form

8 or u Move to the previous page of the form

You can also use the Prev Page and Next Page options on
the Page Menu to move from page to page.
If you want to go to another form, use the following keys:

Press… To…

7 See a list of forms from which you can select

5 Go to the previous form

6 Go to the next form

You can also use the Prev, Next, and Load options on the Form
Menu to move to another form.

Printing an ACORD Form

When you are ready to print the ACORD form,

1. Type A + F at the same time to select and open the Form
Menu.

4. If this is the form you want to fill out, you can begin filling it
out immediately. For help figuring out how to fill in a field,
check the prompt line at the bottom of the screen.

The following keys will help you fill out the form:

Press… To…

J Move from field to field

9 or d Move to the next page of the form

8 or u Move to the previous page of the form

You can also use the Prev Page and Next Page options on
the Page Menu to move from page to page.
If you want to go to another form, use the following keys:

Press… To…

7 See a list of forms from which you can select

5 Go to the previous form

6 Go to the next form

You can also use the Prev, Next, and Load options on the Form
Menu to move to another form.

Printing an ACORD Form

When you are ready to print the ACORD form,

1. Type A + F at the same time to select and open the Form
Menu.
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2. Type P to select the Print  option. The Print Dialog Box appears.

Whenever all the fields display the correct
information, skip to step 14. If all the default
options are correct, you can skip to step 14 now.

3. Press b and t to highlight each form you want to print, and
then press s to mark them.

4. Press F.
5. If more than one printer is listed, press b and t to highlight the

printer to which you want to print.
6. Press F.
7. In the Enhance Printout, Download Laser Fonts, Non-Graphical

Laser Print, and Print Empty Pages fields, press s to
mark the appropriate options:

• Mark Enhance Printout if you are printing on a dot matrix
printer and need final rather than draft quality

• Mark Download Laser Fonts the first time you print to a
laser printer each session

• Mark Non-Graphical Laser Print if you are printing on a
laser printer and want draft rather than final quality

• Mark Print Empty Pages if you want to print a blank form

2. Type P to select the Print  option. The Print Dialog Box appears.

Whenever all the fields display the correct
information, skip to step 14. If all the default
options are correct, you can skip to step 14 now.

3. Press b and t to highlight each form you want to print, and
then press s to mark them.

4. Press F.
5. If more than one printer is listed, press b and t to highlight the

printer to which you want to print.
6. Press F.
7. In the Enhance Printout, Download Laser Fonts, and Non-

Graphical Laser Print, and Print Empty Pages fields, press
s to mark the appropriate options:

• Mark Enhance Printout if you are printing on a dot matrix
printer and need final rather than draft quality

• Mark Download Laser Fonts the first time you print to a
laser printer each session

• Mark Non-Graphical Laser Print if you are printing on a
laser printer and want draft rather than final quality

• Mark Print Empty Pages if you want to print a blank form
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8. Press F.
9. Type the number of copies you want to print.
10. Press F.
11. If the default producer option is not correct, press s, the

first letter, or 4 to select another option.
12. Press F.
13. If the default agency option is not correct, press s, the first

letter, or 4 to select another option.
14. If all the information is now correct, press J. The document

prints to the selected printer.

Saving an ACORD Form
To save the ACORD form(s) you have filled out for a client,

1. When you are ready to save, type A + F at the same time to
select and open the Form Menu.

2. Type S to select the Save option.

The form(s) are saved.

Exiting the ACORDS Form Processor

To exit the ACORD forms and return to the Policy Rating Summary
Screen, either press 3 or select the Exit option from the Form
Menu.

If you try to exit and you haven’t saved the form(s), a question will
pop up asking if you wish to save.

8. Press F.
9. Type the number of copies you want to print.
10. Press F.
11. If the default producer option is not correct, press s, the

first letter, or 4 to select another option.
12. Press F.
13. If the default agency option is not correct, press s, the first

letter, or 4 to select another option.
14. If all the information is now correct, press J. The document

prints to the selected printer.

Saving an ACORD Form
To save the ACORD form(s) you have filled out for a client,

1. When you are ready to save, type A + F at the same time to
select and open the Form Menu.

2. Type S to select the Save option.

The form(s) are saved.

Exiting the ACORDS Form Processor

To exit the ACORD forms and return to the Policy Rating Summary
Screen, either press 3 or select the Exit option from the Form
Menu.

If you try to exit and you haven’t saved the form(s), a question will
pop up asking if you wish to save.
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CHAPTER 16

Setting Defaults and Preferences
This chapter covers how to

• Create and load default sets
• Set system preferences

Creating and Loading Default Sets
Your system comes with some default sets already created, and you
can create your own as well. For example, you may want to create
default sets for each of your most common limits. That way, when
you start a new quote, you can select a default set and most of the
fields on the Coverage Screen will be pre-filled.

You cannot edit the Generic default set.

To select a default set before starting a new quote,

If you have the Pre-Select Defaults option on the Preferences Dialog
Box marked, then a list of defaults will display when you start a new
quote. To select the default set you want,

1. Press b or t to highlight the default set you want.
2. Press J.

You can also bring up the list of default sets by pressing S +
9 or by selecting Defaults from the Utilities Pulldown Menu and
then selecting Sets from the Default Sub-Menu.

CHAPTER 16

Setting Defaults and Preferences
This chapter covers how to

• Create and load default sets
• Set system preferences

Creating and Loading Default Sets
Your system comes with some default sets already created, and you
can create your own as well. For example, you may want to create
default sets for each of your most common limits. That way, when
you start a new quote, you can select a default set and most of the
fields on the Coverage Screen will be pre-filled.

You cannot edit the Generic default set.

To select a default set before starting a new quote,

If you have the Pre-Select Defaults option on the Preferences Dialog
Box marked, then a list of defaults will display when you start a new
quote. To select the default set you want,

1. Press b or t to highlight the default set you want.
2. Press J.

You can also bring up the list of default sets by pressing S +
9 or by selecting Defaults from the Utilities Pulldown Menu and
then selecting Sets from the Default Sub-Menu.
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To create a default set,

1. Type A + U to open the Utilities Menu.
2. Type D to select the Defaults option.
3. Type E to select Editor. The Default Screen is displayed.

4. Press J to open the File Menu.
5. Press J to select the highlighted Setup option. The Default

Setup Dialog Box, which lists existing default sets, is displayed.

To create a default set,

1. Type A + U to open the Utilities Menu.
2. Type D to select the Defaults option.
3. Type E to select Editor. The Default Screen is displayed.

4. Press J to open the File Menu.
5. Press J to select the highlighted Setup option. The Default

Setup Dialog Box, which lists existing default sets, is displayed.



Advanced Rating Functions

1056/29/98

Advanced Rating Functions

1056/29/98

6. Type A + A to select the ADD pushbutton. The Add Default
Dialog Box is displayed.

7. Type the name you want to assign to this default set.
8. Press F.
9. If you have more than one default, press s to select a base

default.
10. Type A + O to select the OK pushbutton.

11. Type V to open the View Menu.
12. Use the arrow keys or hot key to select the screen for which you

want to set defaults. The Default Screen displays all the fields
from the selected screen.

13. Press J to move from column to column, setting defaults and
marking options. You can also press b or t  to move up and
down through a column.

Some screens have more fields than you can see at once. If the
lower right corner of the screen says [ PAGE DOWN ], then you
need to press d to access any additional fields.

See the list below for help completing the columns:

• In the Default Value column, either type the default or
press 4 to select from the list. When you start a new
quote using this default set, the fields will be pre-filled with
the information from this column.

• In the Use Prev Value column, press s to mark or
unmark the fields. If you mark it, then when you start a new

6. Type A + A to select the ADD pushbutton. The Add Default
Dialog Box is displayed.

7. Type the name you want to assign to this default set.
8. Press F.
9. If you have more than one default, press s to select a base

default.
10. Type A + O to select the OK pushbutton.

11. Type V to open the View Menu.
12. Use the arrow keys or hot key to select the screen for which you

want to set defaults. The Default Screen displays all the fields
from the selected screen.

13. Press J to move from column to column, setting defaults and
marking options. You can also press b or t  to move up and
down through a column.

Some screens have more fields than you can see at once. If the
lower right corner of the screen says [ PAGE DOWN ] , then you
need to press d to access any additional fields.

See the list below for help completing the columns:

• In the Default Value column, either type the default or press
4 to select from the list. When you start a new quote using
this default set, the fields will be pre-filled with the
information from this column.

• In the Use Prev Value column, press s to mark or
unmark the fields. If you mark it, then when you start a new
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quote using this default set, the field will default to
whatever you entered in the same field for the previous
item.

• In the Ask on Quick Quote column, press s to mark
or unmark the fields.  If you mark it, then when you start a
new quick quote using this default set, the field will be asked
on the quick quote screens.

 14.When you are done setting defaults for this screen, you can either
set defaults for another screen or exit the default editor.

To set defaults for another screen,

14-1. Type A + V to open the View Menu.
14-2. Use the arrow keys or hot key to select the screen for

which you want to set defaults. The system asks if you
want to save the defaults you set for the current screen.

14-3. Press J to select the Yes pushbutton and save the
defaults. The defaults for the current screen are saved,
and the Default Screen displays all the fields from the
newly selected screen.

14-4. Repeat step 13 for the new screen.

To exit the default editor,

14-1 Type A + F to open the File Menu.
14-2. Type X to select the Exit option. If you didn’t save the

final screen, the system asks if you want to save.
14-3. Press J to select the Yes pushbutton and save the

defaults. You return to the rating screens.

quote using this default set, the field will default to whatever
you entered in the same field for the previous item.

• In the Ask on Quick Quote column, press s to mark
or unmark the fields.  If you mark it, then when you start a
new quick quote using this default set, the field will be asked
on the quick quote screens.

 14.When you are done setting defaults for this screen, you can either
set defaults for another screen or exit the default editor.

To set defaults for another screen,

14-1. Type A + V to open the View Menu.
14-2. Use the arrow keys or hot key to select the screen for

which you want to set defaults. The system asks if you
want to save the defaults you set for the current screen.

14-3. Press J to select the Yes pushbutton and save the
defaults. The defaults for the current screen are saved,
and the Default Screen displays all the fields from the
newly selected screen.

14-4. Repeat step 13 for the new screen.

To exit the default editor,

14-1 Type A + F to open the File Menu.
14-2. Type X to select the Exit option. If you didn’t save the

final screen, the system asks if you want to save.
14-3. Press J to select the Yes pushbutton and save the

defaults. You return to the rating screens.
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To change lines of business,

1. Type A + L  to open the LOB Menu. This menu lists all lines of
business on your system. The current line of business is listed but
cannot be highlighted.

2. Press b or t  to highlight the line of business you want to
select.

3. Press J.

To check the line of business, look at the screen options listed on the
View Menu.

To edit a default set,

1. Type A + U to open the Utilities Menu.
2. Type D to select the Defaults option.
3. Type E to select Editor. The Default Screen is displayed.
4. Press J to open the File Menu.
5. Type L  to select the Load option. A box listing default sets is

displayed.
6. Highlight the default set you want to edit.
7. Type A + O to select the OK pushbutton.
8. Type V to open the View Menu.
9. Use the arrow keys or hot key to select the screen for which you

want to set defaults. The Default Screen displays all the fields
from the selected screen.

10. Make whatever changes you wish to make to the default set.
11. When you are done editing defaults for this screen, you can either

edit defaults for another screen or exit the default editor.

To edit defaults for another screen,

11-1. Type A + V to open the View Menu.
11-2. Use the arrow keys or hot key to select the screen for

which you want to set defaults. The system asks if you
want to save the defaults you set for the current screen.

11-3. Press J to select the Yes pushbutton and save the
defaults. The defaults for the current screen are saved,

To change lines of business,

1. Type A + L  to open the LOB Menu. This menu lists all lines of
business on your system. The current line of business is listed but
cannot be highlighted.

2. Press b or t  to highlight the line of business you want to
select.

3. Press J.

To check the line of business, look at the screen options listed on the
View Menu.

To edit a default set,

1. Type A + U to open the Utilities Menu.
2. Type D to select the Defaults option.
3. Type E to select Editor. The Default Screen is displayed.
4. Press J to open the File Menu.
5. Type L  to select the Load option. A box listing default sets is

displayed.
6. Highlight the default set you want to edit.
7. Type A + O to select the OK pushbutton.
8. Type V to open the View Menu.
9. Use the arrow keys or hot key to select the screen for which you

want to set defaults. The Default Screen displays all the fields
from the selected screen.

10. Make whatever changes you wish to make to the default set.
11. When you are done editing defaults for this screen, you can either

edit defaults for another screen or exit the default editor.

To edit defaults for another screen,

11-1. Type A + V to open the View Menu.
11-2. Use the arrow keys or hot key to select the screen for

which you want to set defaults. The system asks if you
want to save the defaults you set for the current screen.

11-3. Press J to select the Yes pushbutton and save the
defaults. The defaults for the current screen are saved,
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and the Default Screen displays all the fields from the
newly selected screen.

11-4. Repeat step 13 for the new screen.

To exit the default editor,

11-1 Type A + F to open the File Menu.
11-2. Type X to select the Exit option. If you didn’t save the

final screen, the system asks if you want to save.
11-3. Press J to select the Yes pushbutton and save the

defaults. You return to the rating screens.

To change a default set and save it under a new name,

You can use the base default option to create a new default set while
keeping the original. For example, say that you want one default set
with 50/100 limits and one with 100/300 limits, with all the other
information the same. Rather than entering all the information twice,
you can create the 50/100 default set, and then use it as the base for
the 100/300 default set. All you would have to change is the limits.

On the Add Default Dialog Box,

1. Type the new name for the default in the New Name field.
2. Press F to the Base Default field.
3. Press s to choose the default set you want to change.
4. Press J.

Now you can change whatever you need to in the new default set. It
will be saved under the new name, and your original default set is
unchanged.

and the Default Screen displays all the fields from the
newly selected screen.

11-4. Repeat step 13 for the new screen.

To exit the default editor,

11-1 Type A + F to open the File Menu.
11-2. Type X to select the Exit option. If you didn’t save the

final screen, the system asks if you want to save.
11-3. Press J to select the Yes pushbutton and save the

defaults. You return to the rating screens.

To change a default set and save it under a new name,

You can use the base default option to create a new default set while
keeping the original. For example, say that you want one default set
with 50/100 limits and one with 100/300 limits, with all the other
information the same. Rather than entering all the information twice,
you can create the 50/100 default set, and then use it as the base for
the 100/300 default set. All you would have to change is the limits.

On the Add Default Dialog Box,

1. Type the new name for the default in the New Name field.
2. Press F to the Base Default field.
3. Press s to choose the default set you want to change.
4. Press J.

Now you can change whatever you need to in the new default set. It
will be saved under the new name, and your original default set is
unchanged.

See pages 104-
105 if you need
help accessing
the Add Default
Dialog Box.

See pages 104-
105 if you need
help accessing
the Add Default
Dialog Box.
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Setting System Preferences
Other setup items you can change on your system are listed in the
Preferences Dialog Box. To change system preferences,

1. Select the Preferences option from the Options Menu. The
Preferences Dialog Box is displayed.

2. Use the definitions in the following table to determine your
preferences. For most fields, you press s to mark or
unmark the field; the only exceptions are

• the Mins Screen Saver Delay field, where you type the
number of minutes without keyboard or mouse activity to
wait before activating the screen saver

• the Print Optional Ded field, in which you press s or
4 to select an option

Field Definition

Automatic Rate If you mark this field, the premium re-
Calculation calculates automatically whenever you

change input information. Marking this
option may slow processing speed.

Setting System Preferences
Other setup items you can change on your system are listed in the
Preferences Dialog Box. To change system preferences,

1. Select the Preferences option from the Options Menu. The
Preferences Dialog Box is displayed.

2. Use the definitions in the following table to determine your
preferences. For most fields, you press s to mark or
unmark the field; the only exceptions are

• the Mins Screen Saver Delay field, where you type the
number of minutes without keyboard or mouse activity to
wait before activating the screen saver

• the Print Optional Ded field, in which you press s or
4 to select an option

Field Definition

Automatic Rate If you mark this field, the premium re-
Calculation calculates automatically whenever you

change input information. Marking this
option may slow processing speed.
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Field Definition

Show Rating If you mark this field, then messages display
Messages during quoting when input information is

changed or is deemed ineligible/submit by
the underwriting guidelines. Marking this
option may slow processing speed.

Show Rating If you mark this field, Wait messages display
Wait Messages when you rate or re-rate.

Automatic If you mark this field, the territory, symbol,
Lookups and county are looked up automatically.

Return act as If you mark this field, you can use F or
Tab J to move from field to field in a dialog

box. To close a dialog box, you would need
to move to a pushbutton and then press J,
or type A + the pushbutton hot key.

If you leave the field unmarked, you must
use F to move from field to field. Pressing
J at any time closes the box.

Overwrite quote If you mark this field, then when you make
on save changes to a saved quote and re-save it, the

changed quote automatically replaces the
original.

If you leave the field unmarked, the system
asks whether you want to replace the
original quote or make a copy.

Pre-Select If you mark this field, then a Plan Selection
Plans Dialog Box appears when you start a new

quote, allowing you to select companies
before you enter input information.

Field Definition

Show Rating If you mark this field, then messages display
Messages during quoting when input information is

changed or is deemed ineligible/submit by
the underwriting guidelines. Marking this
option may slow processing speed.

Show Rating If you mark this field, Wait messages display
Wait Messages when you rate or re-rate.

Automatic If you mark this field, the territory, symbol,
Lookups and county are looked up automatically.

Return act as If you mark this field, you can use F or
Tab J to move from field to field in a dialog

box. To close a dialog box, you would need
to move to a pushbutton and then press J,
or type A + the pushbutton hot key.

If you leave the field unmarked, you must
use F to move from field to field. Pressing
J at any time closes the box.

Overwrite quote If you mark this field, then when you make
on save changes to a saved quote and re-save it, the

changed quote automatically replaces the
original.

If you leave the field unmarked, the system
asks whether you want to replace the
original quote or make a copy.

Pre-Select If you mark this field, then a Plan Selection
Plans Dialog Box appears when you start a new

quote, allowing you to select companies
before you enter input information.

NEW!NEW!
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Field Definition

Pre-Select If you mark this field, then a Default
Defaults Selection Dialog Box appears when you start

a new quote, allowing you to select a default
set.

r to add item If you mark this field, you can press r to
add an item.

Ask for quote If you mark this field, you will be asked for
description a quote description whenever you save a

quote.

Print Optional Ded If you say Yes in this field, then the printout
will include premiums for other deductible
choices. If you say Ask in this field, then
whenever you print a quote, you will be
asked whether to include the optional
deductibles.

___ Mins Screen Screen saver saves your screen from Saver
Delay “burnout” that can occur if the same text

is on the screen too long. When activated,
screen saver displays a constantly moving
message. You type the number of minutes
to go without touching the keyboard before
the screen saver is activated. To turn the
screen saver off, type 0 in this field.

3. When you are done setting preferences, type A + O to select
the OK pushbutton.

Field Definition

Pre-Select If you mark this field, then a Default
Defaults Selection Dialog Box appears when you start

a new quote, allowing you to select a default
set.

r to add item If you mark this field, you can press r to
add an item.

Ask for quote If you mark this field, you will be asked for
description a quote description whenever you save a

quote.

Print Optional Ded If you say Yes in this field, then the printout
will include premiums for other deductible
choices. If you say Ask in this field, then
whenever you print a quote, you will be
asked whether to include the optional
deductibles.

___ Mins Screen Screen saver saves your screen from Saver
Delay “burnout” that can occur if the same text

is on the screen too long. When activated,
screen saver displays a constantly moving
message. You type the number of minutes
to go without touching the keyboard before
the screen saver is activated. To turn the
screen saver off, type 0 in this field.

3. When you are done setting preferences, type A + O to select
the OK pushbutton.
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CHAPTER 17

Customizing Companies
To customize your rating system, you can delete companies and you
can create your own groups of companies to supplement the regular
groups (most preferred, preferred, standard, and non-standard) that
come with your system. You cannot change the companies assigned
to the regular groups.

Deleting Companies

To delete companies from your rating system,

1. Type A + U to open the Utilities Menu.
2. Type C to select Delete Company. The Delete Company Box is

displayed.

CHAPTER 17

Customizing Companies
To customize your rating system, you can delete companies and you
can create your own groups of companies to supplement the regular
groups (most preferred, preferred, standard, and non-standard) that
come with your system. You cannot change the companies assigned
to the regular groups.

Deleting Companies

To delete companies from your rating system,

1. Type A + U to open the Utilities Menu.
2. Type C to select Delete Company. The Delete Company Box is

displayed.

NEW! NEW!
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3. If you have more than one state, press b to select the state from
which you want to delete.

4. Press F  to the Line of Business section.
5. Press b to select the line of business from which you want to

delete.
6. Press A + P to select the PROCESS button. The Delete

Effective Dates Dialog Box is displayed, listing all available
effective dates for all your companies.

7. Press b through the list of companies, pressing s to mark
any company you want to delete.

8. When all the companies you want to delete are marked, press A
+ D to select the DELETE button. A confirmation box is
displayed.

9. Press J to confirm the deletion or E to cancel.

Creating Plan Groupings

You can create your own groups of companies to supplement the
regular groups (most preferred, preferred, standard, and non-
standard) that come with your system. You cannot change the
companies assigned to the regular groups.

3. If you have more than one state, press b to select the state from
which you want to delete.

4. Press F  to the Line of Business section.
5. Press b to select the line of business from which you want to

delete.
6. Press A + P to select the PROCESS button. The Delete

Effective Dates Dialog Box is displayed, listing all available
effective dates for all your companies.

7. Press b through the list of companies, pressing s to mark
any company you want to delete.

8. When all the companies you want to delete are marked, press A
+ D to select the DELETE button. A confirmation box is
displayed.

9. Press J to confirm the deletion or E to cancel.

Creating Plan Groupings

You can create your own groups of companies to supplement the
regular groups (most preferred, preferred, standard, and non-
standard) that come with your system. You cannot change the
companies assigned to the regular groups.



Advanced Rating Functions

1156/29/98

Advanced Rating Functions

1156/29/98

Adding a Group

To create your own groups,

1. Type A + U to open the Utilities Menu.
2. Choose the Plan Grouping option. The Group Assignment Dialog

Box is displayed.

3.

3. Type A + A to choose the Add pushbutton. The Add Group
Dialog Box is displayed.

4. Type the name of the group.

Adding a Group

To create your own groups,

1. Type A + U to open the Utilities Menu.
2. Choose the Plan Grouping option. The Group Assignment Dialog

Box is displayed.

3.

3. Type A + A to choose the Add pushbutton. The Add Group
Dialog Box is displayed.

4. Type the name of the group.
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5. Press J. A box is displayed asking if you want to use a
system-defined group as the basis for the new group.

6. If you want to create the group from a system-defined group,
type Y and continue to step 7. The companies in that group will
be in your new group. Otherwise, type N and skip to step 8.

7. A box listing the system-defined groups is displayed. To mark the
groups whose companies you want defaulted in your new group,
press b and t to move through the list, pressing s to
mark groups.

8. Press J. The Group Assignment Dialog Box is re-displayed. If
you chose a group or groups as the template, those companies are
already marked.

9. Press F to move to the list of companies.
10. To mark all companies that you want included in your group,

press b and t to move through the list, pressing s to
mark or unmark companies.

11. When only the companies you want to include in your group are
marked, press A + S to save the group.

12. Press A + X to exit the Group Assignment Dialog Box.

5. Press J. A box is displayed asking if you want to use a
system-defined group as the basis for the new group.

6. If you want to create the group from a system-defined group,
type Y and continue to step 7. The companies in that group will
be in your new group. Otherwise, type N and skip to step 8.

7. A box listing the system-defined groups is displayed. To mark the
groups whose companies you want defaulted in your new group,
press b and t to move through the list, pressing s to
mark groups.

8. Press J. The Group Assignment Dialog Box is re-displayed. If
you chose a group or groups as the template, those companies are
already marked.

9. Press F to move to the list of companies.
10. To mark all companies that you want included in your group,

press b and t to move through the list, pressing s to
mark or unmark companies.

11. When only the companies you want to include in your group are
marked, press A + S to save the group.

12. Press A + X to exit the Group Assignment Dialog Box.
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Changing Lines of Business

To change the line of business for which you are creating groups,

1. Type A + U to open the Utilities Menu.
2. Choose the Plan Grouping option. The Group Assignment Dialog

Box is displayed.
3. Type A + T to choose the Setup pushbutton. The Setup Plans

Dialog Box is displayed.

4. Press s to choose the line of business.
5. If you need to change the state or product, press F to that field,

and press s to change it.
6. Press A + O to choose the OK pushbutton.

Changing the Plans in a Group

To change the plans you have assigned to a group,

1. Type A + U to open the Utilities Menu.
2. Choose the Plan Grouping option. The Group Assignment Dialog

Box is displayed.
3. Press b and t to highlight the group whose plans you want to

change.
4. Press F to move to the list of companies.
5. Press b and t to move through the list, pressing s to

mark or unmark companies.

Changing Lines of Business

To change the line of business for which you are creating groups,

1. Type A + U to open the Utilities Menu.
2. Choose the Plan Grouping option. The Group Assignment Dialog

Box is displayed.
3. Type A + T to choose the Setup pushbutton. The Setup Plans

Dialog Box is displayed.

4. Press s to choose the line of business.
5. If you need to change the state or product, press F to that field,

and press s to change it.
6. Press A + O to choose the OK pushbutton.

Changing the Plans in a Group

To change the plans you have assigned to a group,

1. Type A + U to open the Utilities Menu.
2. Choose the Plan Grouping option. The Group Assignment Dialog

Box is displayed.
3. Press b and t to highlight the group whose plans you want to

change.
4. Press F to move to the list of companies.
5. Press b and t to move through the list, pressing s to

mark or unmark companies.
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6. When only the companies you want to include in your group are
marked, press A + S to save the group.

7. Press A + X to exit the Group Assignment Dialog Box.

Deleting a Group

You can only delete groups that you have created. You cannot delete
the system-defined groups.

To delete a group,

1. Type A + U to open the Utilities Menu.
2. Choose the Plan Grouping option. The Group Assignment Dialog

Box is displayed.
3. Type A + D to choose the Delete pushbutton. The Delete

Groups Dialog Box is displayed.
4. To mark the groups that you want to delete, press b and t to

move through the list, pressing s to mark groups.
5. Press J. A confirmation box is displayed.
6. Press J again to confirm the deletion.

6. When only the companies you want to include in your group are
marked, press A + S to save the group.

7. Press A + X to exit the Group Assignment Dialog Box.

Deleting a Group

You can only delete groups that you have created. You cannot delete
the system-defined groups.

To delete a group,

1. Type A + U to open the Utilities Menu.
2. Choose the Plan Grouping option. The Group Assignment Dialog

Box is displayed.
3. Type A + D to choose the Delete pushbutton. The Delete

Groups Dialog Box is displayed.
4. To mark the groups that you want to delete, press b and t to

move through the list, pressing s to mark groups.
5. Press J. A confirmation box is displayed.
6. Press J again to confirm the deletion.
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CHAPTER 18

Writing Letters
The Editor is a simple yet powerful word-processing program that
allows you to create, maintain and print personalized form letters to
send to clients and prospects. It includes automatic word wrap and
re-formatting features, so you do not need to press J at the end of
every line. The letters can be up to 250 lines long. Once you reach
250 lines, you cannot add lines at the end of your letter. If you insert
lines elsewhere, all lines pushed past 250 will be lost.

This chapter tells you how to

• Access the Letter Editor
• Format your letter
• Load documents and includes
• Write documents and includes and link them to client data
• Save documents and includes
• Delete letters
• Print letters
• Leave the Letter Editor

Accessing the Editor

To access the Editor from the AMS Rating Menu,

1. At the AMS Rating Menu, type U to select and open the Utilities
Menu.

2. Type E to select the Editor  option. The Editor Screen appears,
with the New Letter Dialog Box open.
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If you want to start a new letter, you can do so immediately.

If you want to do other tasks (for example, load a letter or set
margins), press E to remove the New Letter Dialog Box before
continuing.

Formatting Letters
Before you begin a letter, you may want to define some specifications
and format the letter. This section covers how to

• Set margins
• Set tabs
• Set up headers and footers
• Position individual lines (i.e. center and left/right justify)

The notched line below the Action Bar (each notch represents a space
on an 80-character line) shows your margins and tabs: margins are
indicated by brackets while plus signs indicate tabs.

Setting Margins

To set margins for your document,

1. From the Editor Screen, type A + L  at the same time to select
and open the Layout Menu.

2. Type M  to select the Margins option. The Margins Dialog Box
is displayed.

If you want to start a new letter, you can do so immediately.

If you want to do other tasks (for example, load a letter or set
margins), press E to remove the New Letter Dialog Box before
continuing.

Formatting Letters
Before you begin a letter, you may want to define some specifications
and format the letter. This section covers how to

• Set margins
• Set tabs
• Set up headers and footers
• Position individual lines (i.e. center and left/right justify)

The notched line below the Action Bar (each notch represents a space
on an 80-character line) shows your margins and tabs: margins are
indicated by brackets while plus signs indicate tabs.

Setting Margins

To set margins for your document,

1. From the Editor Screen, type A + L  at the same time to select
and open the Layout Menu.

2. Type M  to select the Margins option. The Margins Dialog Box
is displayed.
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3. Type in your margin dimensions (from 0 to 20).

Margins are set in columns (left and right) and
lines (top and bottom). For example, the left margin
is the number of columns from the left side of the
page and the top margin is the number of lines
from the top of the page.

4. Press J. The Editor Screen reappears and the ruler changes to
reflect the left and right margins (the top and bottom margins are
only reflected when you print).

If most of your letters use the same margins, you
can set default margins. To do so, select Defaults
on the Layout Menu in step 2. These margins will
automatically be set for every letter, although you
can change them for particular letters using the
Margins option.

Setting Tabs

To change the tab stops,

1. From the Editor Screen, type A + L  at the same time to select
and open the Layout Menu.

2. Type T to select the Tabs option. The cursor moves to the ruler.
3. Press l and r to move the cursor along the ruler, pressing

s where you want to set or remove a tab.
4. When you are done changing tabs, press J.

Setting Headers and Footers

Headers and footers are titles you can put at the top and bottom of
each page of a letter. Headers are at the top of the page and footers at
the bottom. Each document can have a header, footer, or both.

Headers and
footers are
titles you can
place at the top
and bottom of
each page.

3. Type in your margin dimensions (from 0 to 20).

Margins are set in columns (left and right) and
lines (top and bottom). For example, the left margin
is the number of columns from the left side of the
page and the top margin is the number of lines
from the top of the page.

4. Press J. The Editor Screen reappears and the ruler changes to
reflect the left and right margins (the top and bottom margins are
only reflected when you print).

If most of your letters use the same margins, you
can set default margins. To do so, select Defaults
on the Layout Menu in step 2. These margins will
automatically be set for every letter, although you
can change them for particular letters using the
Margins option.

Setting Tabs

To change the tab stops,

1. From the Editor Screen, type A + L  at the same time to select
and open the Layout Menu.

2. Type T to select the Tabs option. The cursor moves to the ruler.
3. Press l and r to move the cursor along the ruler, pressing

s where you want to set or remove a tab.
4. When you are done changing tabs, press J.

Setting Headers and Footers

Headers and footers are titles you can put at the top and bottom of
each page of a letter. Headers are at the top of the page and footers at
the bottom. Each document can have a header, footer, or both.

Headers and
footers are
titles you can
place at the top
and bottom of
each page.
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To set a header,

1. From the Editor Screen, type A + L  at the same time to select
and open the Layout Menu.

2. Type H to select the Header option. The Header Dialog Box is
displayed.

3. Indicate the line and column from the edge of the paper where
you want your header to begin.

The header must be outside the top/bottom
margins and inside the left/right margins. For
example, if your left margin is ten and your top
margin is five, a header in the upper left corner of
the page must be above line five and to the right of
column ten.

4. Type your header (one line only).
5. Indicate if you want the header to appear on the first page.
6. Press J.

You create Footers in the same way, except select the Footer option in
step 2.

To set a header,

1. From the Editor Screen, type A + L  at the same time to select
and open the Layout Menu.

2. Type H to select the Header option. The Header Dialog Box is
displayed.

3. Indicate the line and column from the edge of the paper where
you want your header to begin.

The header must be outside the top/bottom
margins and inside the left/right margins. For
example, if your left margin is ten and your top
margin is five, a header in the upper left corner of
the page must be above line five and to the right of
column ten.

4. Type your header (one line only).
5. Indicate if you want the header to appear on the first page.
6. Press J.

You create Footers in the same way, except select the Footer option in
step 2.
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Positioning Individual Lines

Individual lines can be centered, left-justified, or right-justified.

To center a line,

1. Place your cursor on the line you want to center.
2. Highlight Center Line from the Edit Menu.
3. Press J.

To left-justify a line (position it to begin at the left margin),

1. Place your cursor on the line you want to left-justify.
2. Highlight Left Justify Line  from the Edit Menu.
3. Press J.

To right-justify a line (position it so the last character is against the
right margin),

1. Place your cursor on the line you want to right-justify.
2. Highlight Right Justify Line  from the Edit Menu.
3. Press J.

Loading Documents and Includes

The Editor has two types of letters: documents and includes.
Documents are regular, complete letters. Includes are letters or parts
of letters that you write in advance and use as part of other letters
(such as your agency letterhead). Includes help you save time by
reducing the time it takes to write individual letters.

Your system comes with some documents and includes already
created for you. You can also create your own. The easiest way to
create a letter is to combine various includes.

A document is
a full letter. An
include is part
of a letter, such
as the
letterhead, that
you can
“include” in
other letters.

You cannot
center a line
that contains a
keyword.

Positioning Individual Lines

Individual lines can be centered, left-justified, or right-justified.

To center a line,

1. Place your cursor on the line you want to center.
2. Highlight Center Line from the Edit Menu.
3. Press J.

To left-justify a line (position it to begin at the left margin),

1. Place your cursor on the line you want to left-justify.
2. Highlight Left Justify Line  from the Edit Menu.
3. Press J.

To right-justify a line (position it so the last character is against the
right margin),

1. Place your cursor on the line you want to right-justify.
2. Highlight Right Justify Line  from the Edit Menu.
3. Press J.

Loading Documents and Includes

The Editor has two types of letters: documents and includes.
Documents are regular, complete letters. Includes are letters or parts
of letters that you write in advance and use as part of other letters
(such as your agency letterhead). Includes help you save time by
reducing the time it takes to write individual letters.

Your system comes with some documents and includes already
created for you. You can also create your own. The easiest way to
create a letter is to combine various includes.

A document is
a full letter. An
include is part
of a letter, such
as the
letterhead, that
you can
“include” in
other letters.

You cannot
center a line
that contains a
keyword.
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Loading a Document

To load a document (whether one that came with the system or one
you created yourself),

1. From the Editor Screen, type A + F at the same time to select
and open the File Menu.

2. Type L  to select the Load Document option. The Document
Files Dialog Box appears, listing the documents for the active
line of business.

3. If the line of business you need is active, skip to step 6.
Otherwise, press F until the cursor is in the Line of Business
section.

4. Press b and t to select the line of business you want.
5. Press F to move to the list of documents.
6. Press b and t to highlight the document you want to load. (If

you need to see a description of a document, press 4).
7. Press J.

The document is loaded.

Loading a Document

To load a document (whether one that came with the system or one
you created yourself),

1. From the Editor Screen, type A + F at the same time to select
and open the File Menu.

2. Type L  to select the Load Document option. The Document
Files Dialog Box appears, listing the documents for the active
line of business.

3. If the line of business you need is active, skip to step 6.
Otherwise, press F until the cursor is in the Line of Business
section.

4. Press b and t to select the line of business you want.
5. Press F to move to the list of documents.
6. Press b and t to highlight the document you want to load. (If

you need to see a description of a document, press 4).
7. Press J.

The document is loaded.
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Loading an Include

There are two ways to load an include.

Option 1

1. From the Editor Screen, type A + F at the same time to select
and open the File Menu.

2. Type L  to select the Load Document option. The Load
Document Dialog Box is displayed.

3. Press F to select the Includes pushbutton.
4. Press J. The Include Files Dialog Box is displayed, listing all

includes.

5. Press b and t to highlight the include you want to load (to see
a description of the include, press 4).

6. Press J. The Editor Screen reappears with the loaded include.

Loading an Include

There are two ways to load an include.

Option 1

1. From the Editor Screen, type A + F at the same time to select
and open the File Menu.

2. Type L  to select the Load Document option. The Load
Document Dialog Box is displayed.

3. Press F to select the Includes pushbutton.
4. Press J. The Include Files Dialog Box is displayed, listing all

includes.

5. Press b and t to highlight the include you want to load (to see
a description of the include, press 4).

6. Press J. The Editor Screen reappears with the loaded include.



Advanced Rating Functions

1266/29/98

Advanced Rating Functions

1266/29/98

Option 2

1. Place your cursor at the point in the letter where you want the
include to begin.

2. Press A + F to move to the File Menu.
3. Type I  to select the Load Include option. The Include Files

Dialog Box appears, listing all includes.
4. Press b and t to highlight the include you want to load (to see

a description of the include, press 4).
5. Press J. The Editor Screen reappears with the loaded include.

Creating Documents and Includes
To start a new letter,

If you just opened the Editor and the New Letter
Dialog Box is already on the screen, start these
instructions with step 3.

1. From the Editor Screen, type A + F at the same time to open
and select the File Menu.

2. Type N to select the New Document option. The New Letter
Dialog Box is displayed.

Option 2

1. Place your cursor at the point in the letter where you want the
include to begin.

2. Press A + F to move to the File Menu.
3. Type I  to select the Load Include option. The Include Files

Dialog Box appears, listing all includes.
4. Press b and t to highlight the include you want to load (to see

a description of the include, press 4).
5. Press J. The Editor Screen reappears with the loaded include.

Creating Documents and Includes
To start a new letter,

If you just opened the Editor and the New Letter
Dialog Box is already on the screen, start these
instructions with step 3.

1. From the Editor Screen, type A + F at the same time to open
and select the File Menu.

2. Type N to select the New Document option. The New Letter
Dialog Box is displayed.
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3. Use the arrow keys to select the line of business from which you
want to merge information. For example, if you were writing a
proposal letter for auto insurance, you would select Personal
Auto. If you did not need to merge information from a program,
you would select the Generic option.

4. Press J.

Now you can simply type your letter. See the next section on how to
link your letter to client data so that you can merge them.

Linking the Editor to Client Information

You can merge client information into either documents or includes.
If you want to merge information, you first must tell the system
which program you want to merge with.

When you come to a spot in the letter where you want to insert client
information (for example, the client’s name and address), you use
keyword variables. These are words that are linked to client data.
When you merge or print a letter, the keywords are replaced with
client data (See Merging Client Information).

A special keyword you can place in letters is “ASK.” Whenever you
print a letter with the ASK keyword, the computer will ask you what
text you want to insert into the letter in place of ASK. You can enter
up to 60 characters.

Keyword
variables are
words that are
linked to client
data.

The ASK
keyword allows
you to insert up
to 60
characters into
a letter when
printing.
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You access the keywords through the Key Words Dialog Box. Below
is an example.

To place a keyword in a letter,

1. Position your cursor at the place in the letter where you want the
keyword information.

2. Press 4. The Key Words Dialog Box appears.
3. Select the keyword you want:

3-1.Press b to move through the list of keyword categories.
3-2.Press J  in each category to see the keywords in that

category.
3-3.When you see the keyword you want, press F. The first

keyword in the list box becomes highlighted.
3-4.Press b to highlight the keyword you want.
3-5.Press F.

Categories of
Keywords

Justification
Radio Buttons

Dollar Radio
Buttons

Item Number Field

 Keywords

Width Field
Decimal Field

You access the keywords through the Key Words Dialog Box. Below
is an example.

To place a keyword in a letter,

1. Position your cursor at the place in the letter where you want the
keyword information.

2. Press 4. The Key Words Dialog Box appears.
3. Select the keyword you want:

3-1.Press b to move through the list of keyword categories.
3-2.Press J  in each category to see the keywords in that

category.
3-3.When you see the keyword you want, press F. The first

keyword in the list box becomes highlighted.
3-4.Press b to highlight the keyword you want.
3-5.Press F.

Categories of
Keywords

Justification
Radio Buttons

Dollar Radio
Buttons

Item Number Field

 Keywords

Width Field
Decimal Field
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Once you have selected your keyword, the procedure is different
depending on whether you selected a numeric or a non-numeric
keyword (Numeric keywords are marked with an asterisk).

If you selected a numeric keyword, the cursor moves to the Width
field. To complete the screen,

1. In the Width field, type the maximum number of characters in
your variable.

2. Press F. You move to the Decimals field.
3. Type the number of characters you want to the right of the

decimal.
4. Press F. You move to the Dollar radio buttons.
5. Move the radio button to indicate if you want no dollar sign, a

fixed dollar sign (always stays in the same place, regardless of
the amount -- $10.00 or $ 1.00), or a floating dollar sign (moves
depending on the amount -- $10.00 and $1.00).

6. Press J to accept the keyword information and return to the
Editor screen. The keyword variable appears.

If you selected a non-numeric keyword, the cursor again moves to the
Width field.

To complete the screen,

1. In the Width field, type the maximum number of characters in
your variable.

2. Press F. You move to the justification radio buttons.
3. Move the radio button to left-justify, right-justify, or center the

variable within the column width.
4. Press J to accept the keyword information and return to the

Editor Screen. The keyword variable appears.

Also notice the Include Keyword Variable listed under the Other
category. When you use the Include keyword variable, you put a code
in your letter telling the system to put the specified include in your
letter. The include will actually appear when you merge the letter.

Once you have selected your keyword, the procedure is different
depending on whether you selected a numeric or a non-numeric
keyword (Numeric keywords are marked with an asterisk).

If you selected a numeric keyword, the cursor moves to the Width
field. To complete the screen,

1. In the Width field, type the maximum number of characters in
your variable.

2. Press F. You move to the Decimals field.
3. Type the number of characters you want to the right of the

decimal.
4. Press F. You move to the Dollar radio buttons.
5. Move the radio button to indicate if you want no dollar sign, a

fixed dollar sign (always stays in the same place, regardless of
the amount -- $10.00 or $ 1.00), or a floating dollar sign (moves
depending on the amount -- $10.00 and $1.00).

6. Press J to accept the keyword information and return to the
Editor screen. The keyword variable appears.

If you selected a non-numeric keyword, the cursor again moves to the
Width field.

To complete the screen,

1. In the Width field, type the maximum number of characters in
your variable.

2. Press F. You move to the justification radio buttons.
3. Move the radio button to left-justify, right-justify, or center the

variable within the column width.
4. Press J to accept the keyword information and return to the

Editor Screen. The keyword variable appears.

Also notice the Include Keyword Variable listed under the Other
category. When you use the Include keyword variable, you put a code
in your letter telling the system to put the specified include in your
letter. The include will actually appear when you merge the letter.
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To use the Include keyword variable,

1. Place your cursor at the point in the letter where you want the
include to begin.

2. Press 4 to access the Key Words Dialog Box.
3. Press b and t to move the radio button to the Other option.
4. Press F.
5. Select the Include keyword variable.
6. Press J. The Include Files Dialog Box is displayed
7. Highlight the include you want.
8. Press J. The Editor Screen reappears with the INCLUDE

keyword and the name of the include in place.

Saving Documents and Includes

Once you have written a document or include, you can save it:

1. On the Editor Screen, type A + F at the same time to select and
open the File Menu.

2. Type S to select the Save Document option. The Save Dialog
Box is displayed.

3. Type a name for your letter.
4. Press F to move to the Description field.
5. Type a description of the letter (optional).
6. Press F.

To use the Include keyword variable,

1. Place your cursor at the point in the letter where you want the
include to begin.

2. Press 4 to access the Key Words Dialog Box.
3. Press b and t to move the radio button to the Other option.
4. Press F.
5. Select the Include keyword variable.
6. Press J. The Include Files Dialog Box is displayed
7. Highlight the include you want.
8. Press J. The Editor Screen reappears with the INCLUDE

keyword and the name of the include in place.

Saving Documents and Includes

Once you have written a document or include, you can save it:

1. On the Editor Screen, type A + F at the same time to select and
open the File Menu.

2. Type S to select the Save Document option. The Save Dialog
Box is displayed.

3. Type a name for your letter.
4. Press F to move to the Description field.
5. Type a description of the letter (optional).
6. Press F.
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7. Use the arrow keys to select whether you want to save the letter
as a document or an include.

8. Press F.
9. Press b and t to select the line of business under which you

want to save the letter.
10. Press J.

Your letter is saved.

Merging Client Information
Once your document or include is complete and you have saved it,
you can preview the format merging with sample information. To do
so, follow the instructions below:

1. From the Editor Screen, type A + F at the same time to select
and open the File Menu.

2. Type M  to select the Merge Document option. The Document
Files Dialog Box is displayed, listing the documents for the active
line of business.

3. If the line of business you need is active, skip to step 6.
Otherwise, press F until the cursor is in the Line of Business
section.

4. Use the arrow keys to select the line of business you want.
5. Press F to move to the list of documents.
6. Use the arrow keys to highlight the document you want to merge.

(If you need to see a description of a document, press 4).
7. Press J.

The merged letter is displayed on your screen.

7. Use the arrow keys to select whether you want to save the letter
as a document or an include.

8. Press F.
9. Press b and t to select the line of business under which you

want to save the letter.
10. Press J.

Your letter is saved.

Merging Client Information
Once your document or include is complete and you have saved it,
you can preview the format merging with sample information. To do
so, follow the instructions below:

1. From the Editor Screen, type A + F at the same time to select
and open the File Menu.

2. Type M  to select the Merge Document option. The Document
Files Dialog Box is displayed, listing the documents for the active
line of business.

3. If the line of business you need is active, skip to step 6.
Otherwise, press F until the cursor is in the Line of Business
section.

4. Use the arrow keys to select the line of business you want.
5. Press F to move to the list of documents.
6. Use the arrow keys to highlight the document you want to merge.

(If you need to see a description of a document, press 4).
7. Press J.

The merged letter is displayed on your screen.
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Deleting Letters
If you no longer need a stored letter, you can delete it from your
system. To do so, follow the instructions below:

1. From the Editor Screen, type A + F at the same time to select
and open the File Menu.

2. Type D to select the Delete Document option. The Document
Files Dialog Box is displayed, listing the documents for the active
line of business.

3. If the line of business you need is active, skip to step 6.
Otherwise, press F until the cursor is in the Line of Business
section.

4. Use the arrow keys to select the line of business you want.
5. Press F to move to the list of documents.
6. Use the arrow keys to highlight the document you want to merge.

(If you need to see a description of a document, press 4).
7. Press J. A warning message is displayed, verifying that you

want to delete the letter.
8. To continue the deletion, press J.

To cancel the deletion, press F to select the No pushbutton and
then press J.

Printing Letters

To print a letter with client information merged into it, you need to
print from the corresponding program (for example, personal lines
rating, commercial lines rating, or File Miner). To print a generic
letter or to print a letter with the keyword variables rather than the
merged information,

1. Check that your printer is turned on, is ready to print, and has
enough paper.

2. Load the letter you want to print.

Deleting Letters
If you no longer need a stored letter, you can delete it from your
system. To do so, follow the instructions below:

1. From the Editor Screen, type A + F at the same time to select
and open the File Menu.

2. Type D to select the Delete Document option. The Document
Files Dialog Box is displayed, listing the documents for the active
line of business.

3. If the line of business you need is active, skip to step 6.
Otherwise, press F until the cursor is in the Line of Business
section.

4. Use the arrow keys to select the line of business you want.
5. Press F to move to the list of documents.
6. Use the arrow keys to highlight the document you want to merge.

(If you need to see a description of a document, press 4).
7. Press J. A warning message is displayed, verifying that you

want to delete the letter.
8. To continue the deletion, press J.

To cancel the deletion, press F to select the No pushbutton and
then press J.

Printing Letters

To print a letter with client information merged into it, you need to
print from the corresponding program (for example, personal lines
rating, commercial lines rating, or File Miner). To print a generic
letter or to print a letter with the keyword variables rather than the
merged information,

1. Check that your printer is turned on, is ready to print, and has
enough paper.

2. Load the letter you want to print.
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3. Type A + F at the same time to select and open the File Menu.
4. Type P to select the Print  option. The Print Dialog Box appears.

5.  Indicate

• The number of copies (default is one.)
• The length of page (default is 66)
• Whether you want draft or letter quality

6. Press J.

Using the Search Function

The Letter Editor includes a search function so you can search your
document for every occurrence of a word or part of a word.

To use the search function,

1. Place the cursor at the position in the document where you want
the search to begin.

2. Press A + S at the same time. The Search Menu appears with
Find highlighted.

3. Type A + F at the same time to select and open the File Menu.
4. Type P to select the Print  option. The Print Dialog Box appears.

5.  Indicate

• The number of copies (default is one.)
• The length of page (default is 66)
• Whether you want draft or letter quality

6. Press J.

Using the Search Function

The Letter Editor includes a search function so you can search your
document for every occurrence of a word or part of a word.

To use the search function,

1. Place the cursor at the position in the document where you want
the search to begin.

2. Press A + S at the same time. The Search Menu appears with
Find highlighted.
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3. Press J. The Find Dialog Box is displayed.
4. In the Find Dialog Box,

4-1.Type the search factor (the letter, group of letters, or word
that you want to search for).

4-2.Press F to move to the Ignore Case field.
4-3.If you want to find all instances of your search factor, both

upper- and lower-case, press s to mark Ignore Case.
4-4.If you only want to find your search factor when it is a

complete word, press s to mark Whole words only.
(For example, if your search factor was “for“ and you
marked Whole words only, the system would not stop at
“before“ or “forecast.”

4-5.Press J. The cursor moves to the next occurrence of the
search factor in your letter.

You can continue searching for the next occurrence of this same
search factor by

• Pressing 6
OR

• Returning to the Search Menu and selecting Find Next

Leaving the Editor
When you are ready to leave the Editor, either select Exit  from the
File Menu or press 3. You return to the AMS Rating Menu.

The system always reminds you to save your letters if you try to
leave the Letter Editor without doing so.

3. Press J. The Find Dialog Box is displayed.
4. In the Find Dialog Box,

4-1.Type the search factor (the letter, group of letters, or word
that you want to search for).

4-2.Press F to move to the Ignore Case field.
4-3.If you want to find all instances of your search factor, both

upper- and lower-case, press s to mark Ignore Case.
4-4.If you only want to find your search factor when it is a

complete word, press s to mark Whole words only.
(For example, if your search factor was “for“ and you
marked Whole words only, the system would not stop at
“before“ or “forecast.”

4-5.Press J. The cursor moves to the next occurrence of the
search factor in your letter.

You can continue searching for the next occurrence of this same
search factor by

• Pressing 6
OR

• Returning to the Search Menu and selecting Find Next

Leaving the Editor
When you are ready to leave the Editor, either select Exit  from the
File Menu or press 3. You return to the AMS Rating Menu.

The system always reminds you to save your letters if you try to
leave the Letter Editor without doing so.
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CHAPTER 19

AMS Rating Menu Functions
This chapter covers the following AMS Rating Menu functions:

• Deleting multiple files
• Purging your database
• Rebuilding files
• Backing up files
• Restoring files
• Checking your disk statistics
• Checking your DOS version
• Checking your memory
• Exiting to DOS
• Customizing your sign-on command
• Viewing update information
• Using the Technical Support Utilities
• Mapping workstation drives
• Starting non-AMS programs from the AMS Rating

Menu

Deleting Multiple Files

You can do a “batch” delete by effective/expiration date or by line of
business.

1. From the AMS Rating Menu, type U to select and open the
Utilities Menu.

2. Type D to select the Database option. The Database Menu is
displayed.
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Deleting Multiple Files
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3. Type B to select the Batch Delete option. The Batch Processor
Dialog Box is displayed.

4. Press t and b to select a type of date restriction.
5. Press F. If you selected Effective or Expiration Date in the

Date Restriction section, continue to step 6. Otherwise, go to step
8.

6. Type the beginning and ending dates of the time period.
7. Press F to go to the Line of Business section.
8. Press t and b to select the line of business.
9. Press J. All policies in the selected line of business and with

effective /expiration dates in the time period are deleted.

Purging your Database

When you delete clients from your database, they are no longer listed
in the Client List Dialog Box, but they are not physically removed
from the hard drive. You must use the Purge option to remove all
deleted clients from your hard drive. To use the Purge option from the
AMS Rating Menu,

3. Type B to select the Batch Delete option. The Batch Processor
Dialog Box is displayed.

4. Press t and b to select a type of date restriction.
5. Press F. If you selected Effective or Expiration Date in the

Date Restriction section, continue to step 6. Otherwise, go to step
8.

6. Type the beginning and ending dates of the time period.
7. Press F to go to the Line of Business section.
8. Press t and b to select the line of business.
9. Press J. All policies in the selected line of business and with

effective /expiration dates in the time period are deleted.

Purging your Database

When you delete clients from your database, they are no longer listed
in the Client List Dialog Box, but they are not physically removed
from the hard drive. You must use the Purge option to remove all
deleted clients from your hard drive. To use the Purge option from the
AMS Rating Menu,
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1. Type U to open the Utilities Menu.
2. Type D to open the Database menu item.
3. Type P to select Purge. A warning message displays verifying

that you want to remove all deleted clients from your hard drive.

4. Press A + Y to select the Yes button and continue the purge, or
A + N to select the No button and cancel.

5. If you continued, the files are purged. When the purge is
complete, a box displays telling you the purge is complete. Press
J to return to the Database sub-menu.

Once you have purged, you need to rebuild your files. See the next
section for instructions on rebuilding your files.

Rebuilding Files

You may be asked to rebuild your files, or you may want to rebuild
them if you have deleted many clients/policies. To do so,

1. From the AMS Rating Menu, type U to select and open the
Utilities Menu.

2. Type D to select the Database option. The Database Menu is
displayed.

1. Type U to open the Utilities Menu.
2. Type D to open the Database menu item.
3. Type P to select Purge. A warning message displays verifying

that you want to remove all deleted clients from your hard drive.

4. Press A + Y to select the Yes button and continue the purge, or
A + N to select the No button and cancel.

5. If you continued, the files are purged. When the purge is
complete, a box displays telling you the purge is complete. Press
J to return to the Database sub-menu.

Once you have purged, you need to rebuild your files. See the next
section for instructions on rebuilding your files.

Rebuilding Files

You may be asked to rebuild your files, or you may want to rebuild
them if you have deleted many clients/policies. To do so,

1. From the AMS Rating Menu, type U to select and open the
Utilities Menu.

2. Type D to select the Database option. The Database Menu is
displayed.
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3. Press J. The Rebuild Select Dialog Box is displayed.

3. Press b and t to move through the list of systems, pressing
s to mark each system you want to rebuild. If you want to
rebuild all of the systems, just press 6 to mark everything.

4. Press J. The rebuild begins. When it is complete, a message
appears on your screen.

5. Press J to return to the Rebuild Select Dialog Box.
6. To exit the Rebuild Select Dialog Box, press A + C at the same

time or press E.

Backing Up Files
To backup files,

1. From the AMS Rating Menu, type U to select and open the
Utilities Menu.

2. Type B to select the Backup option. The Backup Select Dialog
Box is displayed, listing all types of files on your system that can
be backed up.

3. Press J. The Rebuild Select Dialog Box is displayed.

3. Press b and t to move through the list of systems, pressing
s to mark each system you want to rebuild. If you want to
rebuild all of the systems, just press 6 to mark everything.

4. Press J. The rebuild begins. When it is complete, a message
appears on your screen.

5. Press J to return to the Rebuild Select Dialog Box.
6. To exit the Rebuild Select Dialog Box, press A + C at the same

time or press E.

Backing Up Files
To backup files,

1. From the AMS Rating Menu, type U to select and open the
Utilities Menu.

2. Type B to select the Backup option. The Backup Select Dialog
Box is displayed, listing all types of files on your system that can
be backed up.
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3. Press b and t to move through the list of topics, pressing
s to mark each topic you want to back up. If you want to
back up all of the topics, just press 6 to mark everything.

4. Press F to move to the Backup Name field.
5. Type a name for the backup (for example, the date or the topic

being backed up)
6. Press J. The Backup Estimates Dialog Box is displayed,

listing the number of files and bytes that will be backed up and
the number of diskettes that will be required.

7. Type the letter of the floppy drive to which you want to back up.
8. Press J.

3. Press b and t to move through the list of topics, pressing
s to mark each topic you want to back up. If you want to
back up all of the topics, just press 6 to mark everything.

4. Press F to move to the Backup Name field.
5. Type a name for the backup (for example, the date or the topic

being backed up)
6. Press J. The Backup Estimates Dialog Box is displayed,

listing the number of files and bytes that will be backed up and
the number of diskettes that will be required.

7. Type the letter of the floppy drive to which you want to back up.
8. Press J.



Advanced Rating Functions

1406/29/98

Advanced Rating Functions

1406/29/98

9. Insert a formatted diskette into that drive.

If the diskette is not blank, press AAAAA + E to erase
the disk, AAAAA  + N to insert another diskette, or AAAAA
+ C to cancel the backup process. The selection
you make for the first non-blank diskette will apply
to all diskettes.

10. Press J. The file(s) are backed up. If more diskettes are
needed, insert them when directed by the computer.

11. When the backup is complete, press J to return to the AMS
Rating Menu. Be sure to label the backup diskette(s).

Restoring Files

If you need to restore files you have backed up,

1. From the AMS Rating Menu, type U to select and open the
Utilities Menu.

2. Type R to select the Restore option. The Select Drive Dialog
Box is displayed.

3. Insert the first diskette of the backup into the floppy drive from
which you want to restore.

4. If the Select Drive Dialog Box already displays the drive letter
for the drive from which you are restoring, skip to step 5.
Otherwise, type the letter of the correct drive.

9. Insert a formatted diskette into that drive.

If the diskette is not blank, press AAAAA + E to erase
the disk, AAAAA  + N to insert another diskette, or AAAAA
+ C to cancel the backup process. The selection
you make for the first non-blank diskette will apply
to all diskettes.

10. Press J. The file(s) are backed up. If more diskettes are
needed, insert them when directed by the computer.

11. When the backup is complete, press J to return to the AMS
Rating Menu. Be sure to label the backup diskette(s).

Restoring Files

If you need to restore files you have backed up,

1. From the AMS Rating Menu, type U to select and open the
Utilities Menu.

2. Type R to select the Restore option. The Select Drive Dialog
Box is displayed.

3. Insert the first diskette of the backup into the floppy drive from
which you want to restore.

4. If the Select Drive Dialog Box already displays the drive letter
for the drive from which you are restoring, skip to step 5.
Otherwise, type the letter of the correct drive.
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5. Press J. The Restore Software Dialog Box is displayed.

6. Press b and t to move through the list of topics, pressing
s to mark each item you want to restore.

7. Press J. The restore begins.
8. Insert the remaining diskettes (if there are any) in order as

prompted by the computer.
9. When the restore is complete, press J to return to the AMS

Rating Menu.

Checking your Disk Statistics

To check how much space and memory are used and available on
your hard drives,

1. At the AMS Rating Menu, type U to select and open the Utilities
Menu.

2. Type O to select the DOS option. The DOS Sub-Menu appears.
3. Type C to select the Check Disk option. The Additional

Parameters Dialog Box is displayed.
4. Type the letter of the drive you want to check.
5. Press J. Your disk statistics are displayed on the screen.
6. Press J to return to the Utilities Menu.

Check Disk
does not work
on network
drives.

5. Press J. The Restore Software Dialog Box is displayed.

6. Press b and t to move through the list of topics, pressing
s to mark each item you want to restore.

7. Press J. The restore begins.
8. Insert the remaining diskettes (if there are any) in order as

prompted by the computer.
9. When the restore is complete, press J to return to the AMS

Rating Menu.

Checking your Disk Statistics

To check how much space and memory are used and available on
your hard drives,

1. At the AMS Rating Menu, type U to select and open the Utilities
Menu.

2. Type O to select the DOS option. The DOS Sub-Menu appears.
3. Type C to select the Check Disk option. The Additional

Parameters Dialog Box is displayed.
4. Type the letter of the drive you want to check.
5. Press J. Your disk statistics are displayed on the screen.
6. Press J to return to the Utilities Menu.

Check Disk
does not work
on network
drives.



Advanced Rating Functions

1426/29/98

Advanced Rating Functions

1426/29/98

Checking your DOS Version

To check the DOS version installed on your computer,

1. At the AMS Rating Menu, type U to select and open the Utilities
Menu.

2. Type O to select the DOS option. The DOS Sub-Menu appears.
3. Type V to select the Version option. Your version number is

displayed on the screen.
4. Press J to return to the Utilities Menu.

Checking your Memory

If you have MS DOS 5.0 or greater, you can check your available
memory:

1. At the AMS Rating Menu, type U to select and open the Utilities
Menu.

2. Type O to select the DOS option. The DOS Sub-Menu appears.
3. Type M  to select the Memory Check option. The memory

statistics are displayed on the screen.
4. Press J to return to the Utilities Menu.

Exiting to DOS
To exit to DOS without closing the AMS Rating Menu,

1. At the AMS Rating Menu, type U to select and open the Utilities
Menu.

2. Type O to select the DOS option. The DOS Sub-Menu appears.
3. Type O to select the OS Shell option. You go to the DOS

prompt.

Checking your DOS Version

To check the DOS version installed on your computer,

1. At the AMS Rating Menu, type U to select and open the Utilities
Menu.

2. Type O to select the DOS option. The DOS Sub-Menu appears.
3. Type V to select the Version option. Your version number is

displayed on the screen.
4. Press J to return to the Utilities Menu.

Checking your Memory

If you have MS DOS 5.0 or greater, you can check your available
memory:

1. At the AMS Rating Menu, type U to select and open the Utilities
Menu.

2. Type O to select the DOS option. The DOS Sub-Menu appears.
3. Type M  to select the Memory Check option. The memory

statistics are displayed on the screen.
4. Press J to return to the Utilities Menu.

Exiting to DOS
To exit to DOS without closing the AMS Rating Menu,

1. At the AMS Rating Menu, type U to select and open the Utilities
Menu.

2. Type O to select the DOS option. The DOS Sub-Menu appears.
3. Type O to select the OS Shell option. You go to the DOS

prompt.
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4. When you are done at the DOS prompt and ready to return to the
AMS Rating Menu,

4-1.Type EXIT
4-2.Press J.

Customizing Your Sign-On Command
Customize Signon is useful on multi-user systems, where you have
to select a station and user each time you start the AMS Rating
Menu. The Customize Signon option allows you to save your station
and user sign-on selections so that you get to the AMS Rating Menu
more quickly. To use this option,

1. At the AMS Rating Menu, type U to select and open the Utilities
Menu.

2. Type C to select the Customize Signon option. The Customize
Signon Dialog Box appears.

3. Type the file name you want to use when signing on to the AMS
Rating Menu.

4. Press J.

Now, when you start the AMS Rating Menu, type AMSRATE plus
your sign-on file name. See the Getting Started booklet for complete
start-up instructions.

4. When you are done at the DOS prompt and ready to return to the
AMS Rating Menu,

4-1.Type EXIT
4-2.Press J.

Customizing Your Sign-On Command
Customize Signon is useful on multi-user systems, where you have
to select a station and user each time you start the AMS Rating
Menu. The Customize Signon option allows you to save your station
and user sign-on selections so that you get to the AMS Rating Menu
more quickly. To use this option,

1. At the AMS Rating Menu, type U to select and open the Utilities
Menu.

2. Type C to select the Customize Signon option. The Customize
Signon Dialog Box appears.

3. Type the file name you want to use when signing on to the AMS
Rating Menu.

4. Press J.

Now, when you start the AMS Rating Menu, type AMSRATE plus
your sign-on file name. See the Getting Started booklet for complete
start-up instructions.
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Viewing Update Information

A View Updates option on the Utilities Menu allows you to see a
description of an update either before or after an update diskette has
been installed.
After you install an update diskette, a box displays in the lower right
corner of your menu screen to remind you to view the update
descriptions.

Viewing an Update Description Before Installing a Diskette

1. On the AMS Rating Menu, type U to open the Utilities Menu.
2. Type V to open the View Updates menu item.

Viewing Update Information

A View Updates option on the Utilities Menu allows you to see a
description of an update either before or after an update diskette has
been installed.
After you install an update diskette, a box displays in the lower right
corner of your menu screen to remind you to view the update
descriptions.

Viewing an Update Description Before Installing a Diskette

1. On the AMS Rating Menu, type U to open the Utilities Menu.
2. Type V to open the View Updates menu item.
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3. Type B to select View Before Install. A box displays asking for
the drive letter where the copyset is located.

4. Put your update diskette in a floppy drive and type the drive
letter in the box.

5. Press J. A description of the update is displayed.

6. When you are done viewing the description, press J to return
to the AMS Rating Menu.

Viewing an Update Description After Installing a Diskette

1. On the AMS Rating Menu, type U to open the Utilities Menu.
2. Type V to open the View Updates menu item.

3. Type B to select View Before Install. A box displays asking for
the drive letter where the copyset is located.

4. Put your update diskette in a floppy drive and type the drive
letter in the box.

5. Press J. A description of the update is displayed.

6. When you are done viewing the description, press J to return
to the AMS Rating Menu.

Viewing an Update Description After Installing a Diskette

1. On the AMS Rating Menu, type U to open the Utilities Menu.
2. Type V to open the View Updates menu item.
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3. Type I to select View Installed Update. A list of updates is displayed.

4. Press b or t to highlight the update you want to view.
5. Type A + O to select the OK button. A description of the

update is displayed.

6. When you are done viewing the description, press J to return
to the list of updates.

7. You can now view another update, press A + D to delete the
description of the highlighted update from your hard drive, or
press E to return to the AMS Rating Menu.

3. Type I to select View Installed Update. A list of updates is displayed.

4. Press b or t to highlight the update you want to view.
5. Type A + O to select the OK button. A description of the

update is displayed.

6. When you are done viewing the description, press J to return
to the list of updates.

7. You can now view another update, press A + D to delete the
description of the highlighted update from your hard drive, or
press E to return to the AMS Rating Menu.
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Technical Support Utilities

The Technical Support Sub-Menu located on the Utilities Menu has
five options:

• Hardware Information
• Text File Editor
• File Manager
• Printer Codes
• DOS with Btrieve

These options help the Technical Support Representatives when you
call in. They will instruct you in using the options if you need to use
them. DO NOT USE THESE OPTIONS ON YOUR OWN!

Mapping Workstation Drives

An Advanced option is available through the System Information
Dialog Box. On peer-to-peer systems and other environments, this
option lets you map up to six host drives and their alternate
workstation drives.

Once you map drives, please note that all copysets must be installed
from the Station 01 Host, and only the host can change the system
information and drive mappings.

Technical Support Utilities

The Technical Support Sub-Menu located on the Utilities Menu has
five options:

• Hardware Information
• Text File Editor
• File Manager
• Printer Codes
• DOS with Btrieve

These options help the Technical Support Representatives when you
call in. They will instruct you in using the options if you need to use
them. DO NOT USE THESE OPTIONS ON YOUR OWN!

Mapping Workstation Drives

An Advanced option is available through the System Information
Dialog Box. On peer-to-peer systems and other environments, this
option lets you map up to six host drives and their alternate
workstation drives.

Once you map drives, please note that all copysets must be installed
from the Station 01 Host, and only the host can change the system
information and drive mappings.
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The System Information Dialog Box comes up automatically during
system donfiguration, or you can bring it up by choosing System
from the Setup Menu on the AMS Rating Menu.

To enter mapping information,

1. On the System Information Dialog Box, type A + A to choose
the ADVANCED pushbutton. A verification box is displayed.

2. Type Y to choose the YES pushbutton. The Advanced Drive
Mapping Information Box is displayed.

3. Type the host drive letters and corresponding workstation drive
letters, pressing J to move from field to field.

4. When you are done, press A + O to return to the System
Information Box.

The System Information Dialog Box comes up automatically during
system donfiguration, or you can bring it up by choosing System
from the Setup Menu on the AMS Rating Menu.

To enter mapping information,

1. On the System Information Dialog Box, type A + A to choose
the ADVANCED pushbutton. A verification box is displayed.

2. Type Y to choose the YES pushbutton. The Advanced Drive
Mapping Information Box is displayed.

3. Type the host drive letters and corresponding workstation drive
letters, pressing J to move from field to field.

4. When you are done, press A + O to return to the System
Information Box.
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Starting Non-AMS Programs
from the AMS Rating Menu

The Other Menu allows you to access any program stored on your
computer from the AMS Rating Menu. This section tells you how to
set up the Other Menu and use it to access non-AMS programs.

Setting Up the Other Menu

This section tells you how to

• Access the Menu Generator Dialog Box
• Add items to the Other Menu
• Use the Directory Browser Dialog Box
• Edit Other Menu options
• Delete Other Menu options
• Add pulldown menus
• Edit pulldown menus
• Save the changes to the menu
• Exit the Menu Generator Dialog Box

Accessing the Menu Generator Dialog Box

The Menu Generator Dialog Box allows you to add and edit options
on the Other Menu. To access this box,

1. At the AMS Rating Menu, type S to select and open the Setup
Menu.

Starting Non-AMS Programs
from the AMS Rating Menu

The Other Menu allows you to access any program stored on your
computer from the AMS Rating Menu. This section tells you how to
set up the Other Menu and use it to access non-AMS programs.

Setting Up the Other Menu

This section tells you how to

• Access the Menu Generator Dialog Box
• Add items to the Other Menu
• Use the Directory Browser Dialog Box
• Edit Other Menu options
• Delete Other Menu options
• Add pulldown menus
• Edit pulldown menus
• Save the changes to the menu
• Exit the Menu Generator Dialog Box

Accessing the Menu Generator Dialog Box

The Menu Generator Dialog Box allows you to add and edit options
on the Other Menu. To access this box,

1. At the AMS Rating Menu, type S to select and open the Setup
Menu.



Advanced Rating Functions

1506/29/98

Advanced Rating Functions

1506/29/98

2. Type O to select the Other Menu option. The Menu Generator
Dialog Box is displayed.

From this box, you can add or edit individual options on the Other
Menu, delete options, and add or edit pulldown menus.

You can set up a program so it is listed directly on the Other Menu or
so it is listed as a sub-menu to an option on the Other Menu. If you
are using a sub-menu, the parent is the option on the Other Menu
itself through which you open the sub-menu. For example, the DOS
option on the Utilities Menu has a pulldown menu attached to it.
DOS is the parent option.

If you want to list an item on a sub-menu, use the Add Pulldown or
Edit Pulldown options.

2. Type O to select the Other Menu option. The Menu Generator
Dialog Box is displayed.

From this box, you can add or edit individual options on the Other
Menu, delete options, and add or edit pulldown menus.

You can set up a program so it is listed directly on the Other Menu or
so it is listed as a sub-menu to an option on the Other Menu. If you
are using a sub-menu, the parent is the option on the Other Menu
itself through which you open the sub-menu. For example, the DOS
option on the Utilities Menu has a pulldown menu attached to it.
DOS is the parent option.

If you want to list an item on a sub-menu, use the Add Pulldown or
Edit Pulldown options.



Advanced Rating Functions

1516/29/98

Advanced Rating Functions

1516/29/98

Adding an Option to the Other Menu

The only required information when you add an option is

• The name of the file to execute
• The drive/directory where the file is located
• The name you want on the Other Menu

However, you can also include other information, such as a hot key
and/or a quick key for the menu option.

You can use the “quick” screen or the “advanced” screen to add
options. The quick screen lists only required fields, while the
advanced screen lists all fields. The table below lists the differences.
For definitions of these options, check the Help Screen.

Field Quick Screen Advanced Screen

Menu Type PULLDOWN W/ NO PULLDOWN W/ NO
PULLDOWN only PULLDOWN or

PULLDOWN W/
PULLDOWN

Hot Key None Any letter in menu name

Status Line None Whatever you enter

Menu Order Order item is added Order you specify

Current Status Always ACTIVE ACTIVE, INAC-
TIVE, or blank

Quick Key None Selected key

Parameters None Whatever you enter

Var. Param None Whatever you enter

Pre Function CLS & BANNER CLS ONLY,
BANNER ONLY,
CLS & BANNER,
blank

Post Function Pause Pause or blank

Adding an Option to the Other Menu

The only required information when you add an option is

• The name of the file to execute
• The drive/directory where the file is located
• The name you want on the Other Menu

However, you can also include other information, such as a hot key
and/or a quick key for the menu option.

You can use the “quick” screen or the “advanced” screen to add
options. The quick screen lists only required fields, while the
advanced screen lists all fields. The table below lists the differences.
For definitions of these options, check the Help Screen.

Field Quick Screen Advanced Screen

Menu Type PULLDOWN W/ NO PULLDOWN W/ NO
PULLDOWN only PULLDOWN or

PULLDOWN W/
PULLDOWN

Hot Key None Any letter in menu name

Status Line None Whatever you enter

Menu Order Order item is added Order you specify

Current Status Always ACTIVE ACTIVE, INAC-
TIVE, or blank

Quick Key None Selected key

Parameters None Whatever you enter

Var. Param None Whatever you enter

Pre Function CLS & BANNER CLS ONLY,
BANNER ONLY,
CLS & BANNER,
blank

Post Function Pause Pause or blank
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Follow the instructions below to add an option to the Other Menu
using either the quick or the advanced screen:

1. From the Menu Generator Dialog Box, type A and A at the
same time to select the Add pushbutton. (You can also press F
to highlight this pushbutton and then J to select it.) The
Directory Browser Dialog Box is displayed.

2. Select the executable file for the program you are adding to the
menu.

If you aren’t sure how to use the Directory Browser
Dialog Box to select a file, see the “Using the
Directory Browser” section on page 156.

3. When you have selected the appropriate file, press J. The
Menu Item Information Dialog Box (Quick) appears, with the
Command Line field already filled in with the drive, directory,
and file information.

If you need to return to the Directory Browser
Dialog Box to change any of the Command Line
information, select the Browser pushbutton.

4. In the Menu Name field, press C and B at the same time
to clear the field.

5. Type the name for the program as you want it listed on the Other
Menu.

6. Press F to move to the Working Dir field.
7. Type the drive and directory where this program stores data,

creates work files, etc. For example, if the program is a word
processing program, where do you want to store the documents?

Follow the instructions below to add an option to the Other Menu
using either the quick or the advanced screen:

1. From the Menu Generator Dialog Box, type A and A at the
same time to select the Add pushbutton. (You can also press F
to highlight this pushbutton and then J to select it.) The
Directory Browser Dialog Box is displayed.

2. Select the executable file for the program you are adding to the
menu.

If you aren’t sure how to use the Directory Browser
Dialog Box to select a file, see the “Using the
Directory Browser” section on page 156.

3. When you have selected the appropriate file, press J. The
Menu Item Information Dialog Box (Quick) appears, with the
Command Line field already filled in with the drive, directory,
and file information.

If you need to return to the Directory Browser
Dialog Box to change any of the Command Line
information, select the Browser pushbutton.

4. In the Menu Name field, press C and B at the same time
to clear the field.

5. Type the name for the program as you want it listed on the Other
Menu.

6. Press F to move to the Working Dir field.
7. Type the drive and directory where this program stores data,

creates work files, etc. For example, if the program is a word
processing program, where do you want to store the documents?
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8. If you DO NOT want to add any advanced options, press J.
You return to the Menu Generator Dialog Box, and the new
program name is listed in the Pulldown menu for Other list.

If you want to add any advanced options, continue to step 9.

9. Press A and A at the same time to select the Advanced
pushbutton. (You can also press F to highlight this pushbutton
and then press J to select it.) The Menu Item Information
Dialog Box (Advanced) is displayed. The following fields will
already be filled in with data from the Menu Item Information
Dialog Box (Quick):

• Menu Name
• Program Name
• Extension
• Directory
• Working Dir

You can change any of these fields. In addition, you can access
the Directory Browser Dialog Box by selecting the Browser
pushbutton.

 

8. If you DO NOT want to add any advanced options, press J.
You return to the Menu Generator Dialog Box, and the new
program name is listed in the Pulldown menu for Other list.

If you want to add any advanced options, continue to step 9.

9. Press A and A at the same time to select the Advanced
pushbutton. (You can also press F to highlight this pushbutton
and then press J to select it.) The Menu Item Information
Dialog Box (Advanced) is displayed. The following fields will
already be filled in with data from the Menu Item Information
Dialog Box (Quick):

• Menu Name
• Program Name
• Extension
• Directory
• Working Dir

You can change any of these fields. In addition, you can access
the Directory Browser Dialog Box by selecting the Browser
pushbutton.

 



Advanced Rating Functions

1546/29/98

Advanced Rating Functions

1546/29/98

10. Complete the fields you want to complete, pressing F to move
from field to field. ALL OF THE FIELDS ARE OPTIONAL,
except those already filled in from the quick screen. For example,
all you might want to do is add a hot key. Once you have filled
out the Hot Key field, you can skip to step 11.

Use the following table to help you determine what to enter in
each field. If you need further definitions of any items, check the
Help Screens.

Field… Entry…

Menu Type Press s to select an option:

• PULLDOWN W/ NO PULLDOWN if
the option will not have a second
pulldown menu attached to it.

• PULLDOWN W/ PULLDOWN if the
option will have a second pulldown
menu (a sub-menu) attached to it.

Menu Name Type the program name as you want it to be
listed on the Other Menu.

Hot Key Type the hot key for the menu item. This
must be a letter from the menu name.

Status Line Type the text to appear on the prompt line
when this menu item is highlighted.

Menu Order Type the order in which this item should be
listed on the Other Menu.

Current Status Press s to select an option:

• ACTIVE if you want to be able to
select the option from the Other Menu.

• INACTIVE if you want the option listed
on the Other Menu but you do not want
to select it.

10. Complete the fields you want to complete, pressing F to move
from field to field. ALL OF THE FIELDS ARE OPTIONAL,
except those already filled in from the quick screen. For example,
all you might want to do is add a hot key. Once you have filled
out the Hot Key field, you can skip to step 11.

Use the following table to help you determine what to enter in
each field. If you need further definitions of any items, check the
Help Screens.

Field… Entry…

Menu Type Press s to select an option:

• PULLDOWN W/ NO PULLDOWN if
the option will not have a second
pulldown menu attached to it.

• PULLDOWN W/ PULLDOWN if the
option will have a second pulldown
menu (a sub-menu) attached to it.

Menu Name Type the program name as you want it to be
listed on the Other Menu.

Hot Key Type the hot key for the menu item. This
must be a letter from the menu name.

Status Line Type the text to appear on the prompt line
when this menu item is highlighted.

Menu Order Type the order in which this item should be
listed on the Other Menu.

Current Status Press s to select an option:

• ACTIVE if you want to be able to
select the option from the Other Menu.

• INACTIVE if you want the option listed
on the Other Menu but you do not want
to select it.
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Field Entry

Quick Key Press s to select the quick key to be
assigned to this menu item. (The quick key
allows you to select the option by pressing the
key instead of opening the Other Menu.)

Quick Key If you selected a quick key and want it to be
Desc listed on the prompt line, type the prompt line

description.
Quick Key If you entered a Quick Key Desc, press s
Disp  to select an option:

• DISPLAY ON STATUS LINE if you want
the quick key and description listed on the
status line.

• <none> (blank) if you do not want the quick
key and description listed on the status line.

Program Name Type the name of the file to be executed when you
select this menu item (no extension).

Extension Type the file extension for the file listed in the
Program Name field.

Parameters Type parameters for the file being executed.
Var. Param Type any user prompts for parameters to be

entered when the program starts up.
Directory Type the drive and directory where the file from

the Program Name field is located.
Working Dir Type the drive and directory where this program

stores data, creates work files, etc.

Field Entry

Quick Key Press s to select the quick key to be
assigned to this menu item. (The quick key
allows you to select the option by pressing the
key instead of opening the Other Menu.)

Quick Key If you selected a quick key and want it to be
Desc listed on the prompt line, type the prompt line

description.
Quick Key If you entered a Quick Key Desc, press s
Disp  to select an option:

• DISPLAY ON STATUS LINE if you want
the quick key and description listed on the
status line.

• <none> (blank) if you do not want the quick
key and description listed on the status line.

Program Name Type the name of the file to be executed when you
select this menu item (no extension).

Extension Type the file extension for the file listed in the
Program Name field.

Parameters Type parameters for the file being executed.
Var. Param Type any user prompts for parameters to be

entered when the program starts up.
Directory Type the drive and directory where the file from

the Program Name field is located.
Working Dir Type the drive and directory where this program

stores data, creates work files, etc.
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Field Entry

Pre Function Press s to select an option:

• CLS ONLY if you just want the screen
cleared before the program begins.

• BANNER ONLY if you just want the
“Loading Program” message displayed
before the program begins.

• CLS & BANNER if you want the screen
cleared and the message displayed before the
program begins.

• <none> (blank) if you want the program to
begin without clearing the screen or
displaying the message.

Post Function Press s to select an option:

• PAUSE if you want the "Press any key…”
message when you return to the AMS
Rating Menu.

• <none> (blank) if you just want to return to
the AMS Rating Menu

11. When you have completed the screen, press J. You return to
the Menu Generator Dialog Box, and the new program name is
listed in the Pulldown menu for Other list. You can now add
another menu option, edit a menu option, etc.

Using the Directory Browser

When you add an option to the Other Menu, you must tell the AMS
Rating Menu what file to open and where that file is located. To help
you give this information, the AMS Rating Menu includes a
Directory Browser Dialog Box. This dialog box displays all the
files in a selected drive and directory on your system. For example,

Field Entry

Pre Function Press s to select an option:

• CLS ONLY if you just want the screen
cleared before the program begins.

• BANNER ONLY if you just want the
“Loading Program” message displayed
before the program begins.

• CLS & BANNER if you want the screen
cleared and the message displayed before the
program begins.

• <none> (blank) if you want the program to
begin without clearing the screen or
displaying the message.

Post Function Press s to select an option:

• PAUSE if you want the "Press any key…”
message when you return to the AMS
Rating Menu.

• <none> (blank) if you just want to return to
the AMS Rating Menu

11. When you have completed the screen, press J. You return to
the Menu Generator Dialog Box, and the new program name is
listed in the Pulldown menu for Other list. You can now add
another menu option, edit a menu option, etc.

Using the Directory Browser

When you add an option to the Other Menu, you must tell the AMS
Rating Menu what file to open and where that file is located. To help
you give this information, the AMS Rating Menu includes a
Directory Browser Dialog Box. This dialog box displays all the
files in a selected drive and directory on your system. For example,
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the figure below displays the files in the AMSRATE directory on
drive D.

By changing the drive and directory, you can view all the files on
your system, and can select the file you want.

In order to select a file, you must first find the drive and directory
where the file is located. There are two ways to find the drive and
directory: using the Name field or using the Directories/Drives list.

Name Field

1. If necessary, press C and B at the same time to clear the
Names field.

2. Type the drive (and directory, if there is one) where you think the
file is located. For example, type C:\RATER to list the files in the
RATER directory on the C drive. (You can also type the file
name if you know it.)

3. Press J. If you type a drive/directory only, the Files list
changes to reflect the files in the drive/directory, and you can
select one from the list. If you typed the file name in step 2 as
well, you return to the Menu Item Information Dialog Box.

the figure below displays the files in the AMSRATE directory on
drive D.

By changing the drive and directory, you can view all the files on
your system, and can select the file you want.

In order to select a file, you must first find the drive and directory
where the file is located. There are two ways to find the drive and
directory: using the Name field or using the Directories/Drives list.

Name Field

1. If necessary, press C and B at the same time to clear the
Names field.

2. Type the drive (and directory, if there is one) where you think the
file is located. For example, type C:\RATER to list the files in the
RATER directory on the C drive. (You can also type the file
name if you know it.)

3. Press J. If you type a drive/directory only, the Files list
changes to reflect the files in the drive/directory, and you can
select one from the list. If you typed the file name in step 2 as
well, you return to the Menu Item Information Dialog Box.
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To use the Directories/Drives list,

1. Type A and D at the same time to move the highlight to the
Directories/Drives list.

2. Use the arrow keys to highlight the option you want. You can

• Move to another drive -- to look at the files in D:,
highlight the [ D: ] option.

• Move to a directory/subdirectory in the same drive/
directory -- if the Name field lists D:\MMS and you want
to look at the files and directories in the D:\MMS\DATA
directory, highlight the DATA option.

•  “Back up” a directory level -- If the Name field lists
D:\MMS\DATA and you want to look at the files and
directories in D:\MMS, highlight the “. . ” option
(always the first option in the list).

3. When the option you want is highlighted, press J. The Name
field changes to reflect the selected drive/directory, and the Files
list changes to list the files in this drive/directory.

4. Repeat step 2 until you are at the drive/directory you want.

When you are at the correct drive and directory, the Files list will
display the file you want. To select the file,

1. Type A and F at the same time to move the highlight to the
Files list.

2. Use the arrow keys to highlight the file you want to select.
3. Press J. You return to the Menu Item Information Dialog Box.

Editing Menu Items

To edit an option on the Other Menu,

1. On the Menu Generator Dialog Box, use the arrow keys to
highlight the menu item you want to edit.

To use the Directories/Drives list,

1. Type A and D at the same time to move the highlight to the
Directories/Drives list.

2. Use the arrow keys to highlight the option you want. You can

• Move to another drive -- to look at the files in D:,
highlight the [ D: ] option.

• Move to a directory/subdirectory in the same drive/
directory -- if the Name field lists D:\MMS and you want
to look at the files and directories in the D:\MMS\DATA
directory, highlight the DATA option.

•  “Back up” a directory level -- If the Name field lists
D:\MMS\DATA and you want to look at the files and
directories in D:\MMS, highlight the “. . ” option
(always the first option in the list).

3. When the option you want is highlighted, press J. The Name
field changes to reflect the selected drive/directory, and the Files
list changes to list the files in this drive/directory.

4. Repeat step 2 until you are at the drive/directory you want.

When you are at the correct drive and directory, the Files list will
display the file you want. To select the file,

1. Type A and F at the same time to move the highlight to the
Files list.

2. Use the arrow keys to highlight the file you want to select.
3. Press J. You return to the Menu Item Information Dialog Box.

Editing Menu Items

To edit an option on the Other Menu,

1. On the Menu Generator Dialog Box, use the arrow keys to
highlight the menu item you want to edit.
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2. Type A and E at the same time to select the Edit pushbutton.
(You can also press F to highlight this pushbutton and then
press J to select it.) The Menu Item Information Dialog Box
(Quick) appears.

3. Use the table below to determine your next step:

To change the… Then…

Menu Name or 1. Press F to go to the field you
Working Dir want to change.

2. Make the necessary change.

Command Line 1. Type A and B at the same time
to select the Browser pushbutton.
The Directory Browser Dialog
Box appears.

2. Make the necessary change.
3. Press J to return to the Menu

Item Information Dialog Box
(Quick).

Advanced Options 1. Type A and A at the same time
to select the Advanced pushbutton.
The Menu Item Information Dialog
Box (Advanced) appears.

2. Press F to go to the
field you want to change.

3. Make the necessary change.

4. When you have made all your changes, press J. You return to
the Menu Generator Dialog Box.

2. Type A and E at the same time to select the Edit pushbutton.
(You can also press F to highlight this pushbutton and then
press J to select it.) The Menu Item Information Dialog Box
(Quick) appears.

3. Use the table below to determine your next step:

To change the… Then…

Menu Name or 1. Press F to go to the field you
Working Dir want to change.

2. Make the necessary change.

Command Line 1. Type A and B at the same time
to select the Browser pushbutton.
The Directory Browser Dialog
Box appears.

2. Make the necessary change.
3. Press J to return to the Menu

Item Information Dialog Box
(Quick).

Advanced Options 1. Type A and A at the same time
to select the Advanced pushbutton.
The Menu Item Information Dialog
Box (Advanced) appears.

2. Press F to go to the
field you want to change.

3. Make the necessary change.

4. When you have made all your changes, press J. You return to
the Menu Generator Dialog Box.
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Deleting Menu Items

To delete an option from the Other Menu,

1. On the Menu Generator Dialog Box, press b and t to highlight
the menu item you want to delete.

2. Type A and L at the same time to select the Delete pushbutton
(or press F to highlight this pushbutton and then press J to
select it). A verification box appears.

3. To continue the deletion, press J.

To cancel the deletion, press F to select the No pushbutton and
then press J.

You return to the Menu Generator Dialog Box.

Adding Pulldown Menus

If you select the PULLDOWN W/ PULLDOWN option in the Menu
Type field on the Menu Item Information Dialog Box (Advanced),
you can add a sub-menu to the option. For example, you might want
to group three word processing programs into one sub-menu off of
the Other Menu. An example of a PULLDOWN W/ PULLDOWN
menu is the DOS option on the Utilities Menu.

To add a pulldown menu to an option on the Other Menu,

1. On the Menu Generator Dialog Box, press b and t to highlight
the menu item to which you want to add the pulldown menu. The
item you select must have PULLDOWN W/ PULLDOWN
selected in the Menu Type field on the Menu Item Information
Dialog Box (Advanced).

2. Type A and D at the same time to select the Add Pulldown
pushbutton. (You can also press F to highlight this pushbutton
and then press J to select it). The Menu Item Information
Dialog Box (Quick) is displayed.

Deleting Menu Items

To delete an option from the Other Menu,

1. On the Menu Generator Dialog Box, press b and t to highlight
the menu item you want to delete.

2. Type A and L at the same time to select the Delete pushbutton
(or press F to highlight this pushbutton and then press J to
select it). A verification box appears.

3. To continue the deletion, press J.

To cancel the deletion, press F to select the No pushbutton and
then press J.

You return to the Menu Generator Dialog Box.

Adding Pulldown Menus

If you select the PULLDOWN W/ PULLDOWN option in the Menu
Type field on the Menu Item Information Dialog Box (Advanced),
you can add a sub-menu to the option. For example, you might want
to group three word processing programs into one sub-menu off of
the Other Menu. An example of a PULLDOWN W/ PULLDOWN
menu is the DOS option on the Utilities Menu.

To add a pulldown menu to an option on the Other Menu,

1. On the Menu Generator Dialog Box, press b and t to highlight
the menu item to which you want to add the pulldown menu. The
item you select must have PULLDOWN W/ PULLDOWN
selected in the Menu Type field on the Menu Item Information
Dialog Box (Advanced).

2. Type A and D at the same time to select the Add Pulldown
pushbutton. (You can also press F to highlight this pushbutton
and then press J to select it). The Menu Item Information
Dialog Box (Quick) is displayed.
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4. Complete the information for the option, following the
instructions for Adding an Option to the Other Menu beginning
on page 151.

Editing Pulldown Menus

To edit a pulldown menu for an item on the Other Menu,

1. On the Menu Generator Dialog Box, press b and t to highlight
the parent menu item where the sub-menu you want to edit is
located.

2. Type A and T at the same time to select the Edit Pulldown
pushbutton. (You can also press F to highlight this pushbutton
and then press J to select it). The pulldown menu list changes
to list the pulldown menu items attached to the selected option.

3. Use the arrow keys to highlight the pulldown menu item you
want to edit.

4. Type A and E at the same time to select the Edit pushbutton. (You
can also press F to highlight this pushbutton and then press J to
select it). The Menu Item Information Dialog Box (Quick) is
displayed.

5. Follow the instructions in the Editing Menu Items section on page
158 to make the necessary changes.

To return to the listing of parent menu items, select the Parent
pushbutton.

4. Complete the information for the option, following the
instructions for Adding an Option to the Other Menu beginning
on page 151.

Editing Pulldown Menus

To edit a pulldown menu for an item on the Other Menu,

1. On the Menu Generator Dialog Box, press b and t to highlight
the parent menu item where the sub-menu you want to edit is
located.

2. Type A and T at the same time to select the Edit Pulldown
pushbutton. (You can also press F to highlight this pushbutton
and then press J to select it). The pulldown menu list changes
to list the pulldown menu items attached to the selected option.

3. Use the arrow keys to highlight the pulldown menu item you
want to edit.

4. Type A and E at the same time to select the Edit pushbutton. (You
can also press F to highlight this pushbutton and then press J to
select it). The Menu Item Information Dialog Box (Quick) is
displayed.

5. Follow the instructions in the Editing Menu Items section on page
158 to make the necessary changes.

To return to the listing of parent menu items, select the Parent
pushbutton.
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Saving Menu Changes

Before you exit the Menu Generator Dialog Box, save the changes
you have made to the Other Menu:

1. Type A and S at the same time to select the Save pushbutton.
(You can also press F to highlight this pushbutton and then
press J to select it).

The changes are saved.

If you forget to save before you exit, a warning box will give you the
chance to save then.

Exiting the Menu Generator Dialog Box

To exit the Menu Generator Dialog Box,

1. Type A and X at the same time to select the Exit pushbutton.
(You can also press F to highlight this pushbutton and then
press J to select it).

If you already saved any changes, you return to the Setup Menu.

If you did not save your changes, the Changes not Saved Dialog
Box is displayed. Continue to step 2.

2. If you want to save the changes, press J. You return to the
Setup Menu.

If you do not want to save the changes, press F to select the
NO pushbutton and then press J. You return to the Setup
Menu.

Saving Menu Changes

Before you exit the Menu Generator Dialog Box, save the changes
you have made to the Other Menu:

1. Type A and S at the same time to select the Save pushbutton.
(You can also press F to highlight this pushbutton and then
press J to select it).

The changes are saved.

If you forget to save before you exit, a warning box will give you the
chance to save then.

Exiting the Menu Generator Dialog Box

To exit the Menu Generator Dialog Box,

1. Type A and X at the same time to select the Exit pushbutton.
(You can also press F to highlight this pushbutton and then
press J to select it).

If you already saved any changes, you return to the Setup Menu.

If you did not save your changes, the Changes not Saved Dialog
Box is displayed. Continue to step 2.

2. If you want to save the changes, press J. You return to the
Setup Menu.

If you do not want to save the changes, press F to select the
NO pushbutton and then press J. You return to the Setup
Menu.
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Starting “Other” Programs

All non-AMS programs are listed under the Other Menu. To start one
of these programs,

1. From the AMS Rating Menu, type O to select and open the Other
Menu.

2. Either type the hot key letter of the program you want to open (if
there is a hot key), or use the arrow keys to highlight it and then
press J.

Starting “Other” Programs

All non-AMS programs are listed under the Other Menu. To start one
of these programs,

1. From the AMS Rating Menu, type O to select and open the Other
Menu.

2. Either type the hot key letter of the program you want to open (if
there is a hot key), or use the arrow keys to highlight it and then
press J.
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